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1 Installation 

1.1 License key 

What is the license key? 

A different license key for Windows and for Mac 

Starter Edition mode at no cost 

Entering the license key 

Modifying the license key 

Lost license key 

  

What is the license key?  

It's a code that is being furnished when the program is purchased and that makes the program fully 

operational. 

The license key is furnished in the following ways: 

 in the box, printed on the flyer that comes with the CD 

 sent by email when bought online with a credit card (for those buying at our resellers 

Share.it or Ateneoweb) 

 printed on the invoice (for those buying directly from us). 

IMPORTANT: Keep the license key carefully in a safe place. In case the license key gets lost, 

read our page Lost license key. 

  

A different license key for Windows and for Mac  

According to the user's operating system, different license keys are being furnished. 

If a license key for Mac is being entered on a computer with the Windows operating system (and 

the other way round), the program gives an error message that the license is invalid.  

  

Starter Edition mode at no cost  

If you install the program without entering the license key, the program runs in Starter Edition 

mode. 

With the Starter Edition mode, you can: 
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 Use the program in complete mode, entering up to 70 rows into the Transactions table. 

If you have more than 70 rows in the Transaction table you won't be able to save or export 

the file, and in the print-outs the words "Starter Edition" will appear. 

When the license key is being entered, Banana Accounting switches from the Starter Edition mode 

into the complete mode. 

  

Entering the license key  

 Open Banana Accounting 

 Select the command "Manage license keys" from the "Help" menu 

 Enter the license key number into the appropriate field 

 Click on the "Save license key" button 

 Confirm the operation if asked 

 

After that, the operating system might ask to enter the administrator's credentials. 

The license key is in fact being saved for all the users of the computer. 

  

Modifying the license key  

Once a license key has been entered, the following dialog appears in the Manage license keys 

window: 
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Registration code 

Once the license key has been entered, the program displays the registration code. 

This code is being used to find the license key that has been entered by the user. 

  

Remove License Key 

Serves to remove the license key. 

  

If the license key is not entered, a message that informs the user that he is working in Starter Edition 

mode appears in the information window and besides the file name in the program header. 

  

Lost license Key  

You can ask us - by email - to resend you your own license key. For us to be able to find it, please 

send us the registration code displayed in the Manage license keys window ( Help menu). You 

may also send us a screenshot of that same window. 

Please note: resending you your license key has a cost of 20.- Chf. 

If the registration code cannot be provided, but only a proof of purchase, the costs will be 30.- 

Chf. 

If it is impossible to provide the registration code and/or a proof of purchase, a new license 

needs to be purchased. 
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1.2 Installation on Windows 

The program installation is a matter of minutes and it is all automatic. 

By downloading the program, you accept the user license conditions. 

  

Once the download is finished, just double-click on the file you downloaded. 

 

By clicking on the Next button, you will be carried to the next window. 

http://www.banana.ch/cms/en/user_license
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The software will be saved by default in the C:\Programmi Files\Banana70 folder. If you wish to 

save it in a different folder click on the Browse button and choose the desired path. 

 

The program activates by default the Create a desktop icon and Associate Banana Accounting 

7.0 with the AC2 file extension options; if you do not wish to have this options, simply uncheck 

them. 
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Insert license key 

After opening the program for the first time insert the license key and confirm with OK 

 

By inserting the license key into Banana Accounting, you go from the demo mode to the complete 

mode. If the license key is not inserted, a message appears at the opening of the accounting file, 

warning the user that he is working in demo mode. 

  

Open the software 

As soon as you open the software, choose the New command from the File menu. From the pop-up 

window you will be able to choose your accounting type, the option with or without VAT, the file 
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language, and an example or template (or you can also open a blank file - not recommended) 

 

Note: in order to uninstall the software, please select the Install/Uninstall applications from the 

Control Panel and then chose to remove Banana Accounting from the list. 

  

  

1.3 Installation on Mac 

Installing the software is very easy. 

By downloading the program, you accept the user license conditions. 

  

Follow these steps: 

Download the .dmg file by clicking on the Save file button. 

After saving the file in your Download folder, double click on it 

http://www.banana.ch/cms/en/user_license
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Drag the Banana7 icon in the Applications folder 

 

Banana Accounting 7 Beta is now ready to be used. Double click on the Banana 7 icon from your 

Applications folder. The program is installed in your operating system language, but is always 

possible to change it from the Tools menu, using the Program options command. 

  

After opening the program insert the licence key and confirm with OK. 
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Then launch the New command from the File menu. From the pop up window it is possible to 

choose the accounting type, the with or without VAT management option, the language and a 

template or example (or you can choose to open a blank file - not recommended). 

 

NOTE: in order to uninstall the software, simply drag the Banana7 icon from the Applications 

folder to the Trash. 

  

1.4 Installing on a server 

For Windows 
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If you need to install Banana Accounting on a server (citrix or others) the procedure is simple 

because Banana does not need special components or specific settings for a user.  

To install on your server proceed as follows: 

 follow the normal installation procedure on a local disk 

 enter the license key 

 copy the directory C \ Program Files \ BananaXX \ (XX stands for the version number) on 

the network drive 

 you must then create the connection with the program BananaXX.exe so that users of the 

local computer can run the program 

 

Remember that in order to execute Banana Accounting from multiple computers, you need to buy 

as many licenses as there are computers that use the program. 

  

For Apple/MAC 

It is not possible to install Banana Accounting on servers. The program must be installed and the 

licence key must be entered on each computer. However, you can save the accounting files on a 

network disk. 

  

2 File 

This sections contains all information regarding creating, saving a file and all its contents. 

  

2.1 Create new 

In order to create a new a new accounting file, choose the New command from the File menu 
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Group 

In the Group section all the different applications are listed. Choose the one that meets your needs. 

File 
In this section you can select the characteristics of the choosen application. You can choose 

between the plain version, with the VAT management, with a second currency or with more than 

one currency. 

Examples/Templates 

By selecting the language you will see predefined example/models that you can use to start and that 

can be personalized. All the template data and settings (language, decimal rounding, ..) will be used. 

Once you have personalized the template you need to save the file with a new name. 

  

2.1.1 Convert to new file 

This command converts an existing file with established settings to another with different 

characteristics. In the case of converting a file with more options into one that has fewer options, a 

part of the data will be lost during conversion. If, for example, an accounting file with VAT/Sales 

tax is converted into an accounting file without VAT/Sales tax, during conversion all data in the 

VAT columns will be lost. 
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The following window will then appear: 

 

You can find the explanations of this window at the following page: #2020 

  

2.1.1.1 Changing accounting type 

It may occur that, during the year, it becomes necessary to change from one accounting type to 

another (for example passing from a simple accounting to a double-entry accounting or from a 

double-entry accounting to a double-entry accounting with VAT management). Here is how to 

proceed: 

 from the Tools menu choose the Convert to new file... command 

 from the pop up window that appears, choose the file type you wish to create 
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 By pressing on the OK button a second pop-up window appears when you can choose the 

language and the rounding system of the new file 

 By pressing on the OK button a new file will be created, identical to the original 

(accounting plan, transactions, etc.) but with the new setup you just entered. 

 Save the new file with a name. 

Note: when converting a more complex accounting file into a simpler accounting type, some data 

loss may occur. We strongly suggest NOT to save the new file overwriting the old one. 

  

2.1.1.2 Changing the rounding of the decimal points 

When a file is being created, the user is being asked to enter some basic information. The rounding 

of the decimal points is part of this basic information. 

If, on the contrary, the user wants to change the rouding system of an already created file, proceed 

as follows:  

 From the Tools menu, choose the Convert to new file... command 

The Outline to create a new file window will appeare, where you can change the rounding of the 

decimal points 

  

2.1.1.3 Changing the file language 

When a file is being created, the user is being asked to enter some basic information. The language 

is part of this basic information. 
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If, on the contrary, the user wants to change the language of an already created file, proceed as 

follows: 

 From the Tools menu, choose the Convert to new file... command 

 In the window that opens, choose the type of file to create (if we only want to change the 

language, choose the same accounting type as the existing file) 

 By pressing OK, a second window opens 

 In the section Language, enter the desired language. 

 

 By pressign OK, a file, identical to the original one (chart of accounts, transactions, 

VAT/Sales tax codes), is being created, with the new configurations that you have entered 

(in this case, the change of language) 

 Save the new file under a new name. 

  

2.1.2 Create file copy 

This command creates a copy of the file with the possibility to select the indicated options in the 

window that appears: 

 

2.1.3 Create new empty file 

You will create a new accounting file starting from an empity one. 

In the Examples/Templates section, choose the language/nation and choose the New blank file 

(without data, without chart of accounts). 
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 Setup the  Outline to create new file 

 

 Setup the File and accounting properties 

  

 Create the accounting plan structure 
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2.1.4 Outline to create new file 

 

Language 

The desired language of the headers of the table fields must be selected. 

Decimal points for amounts 

In order to avoid accounting differences, the number of decimal points for the amounts is fixed for 

each file. Two decimal points are normally used, but there are currencies where decimal points are 

not required so 0 needs to be inserted. 

Decimal points for amounts in foreign currency 

If using multi-currency accounting, then it is necessary to define the number of decimal points for 

the amounts in the foreign currency as well. 

Rounding type 

The amounts are rounded up or down to the closest whole number. In the case of exactly half (for 

example: 100.5 / 101.5 / 102.5 / 103.5) the following systems are being used: 

 Banking (Half at even) is being rounded up or down towards the nearest even number (100 

/ 102 / 102 / 104). 

 Commercial/Arithmetic (Half up) is being rounded up to the next whole number (101 / 

102 / 103 / 104). In accounting, this is the system most used. 

 Compatible version 4. A minor precision is being used, which in very special cases, can 

bring forth a different rounding. 

Adress fields in accounts table 

When this option is activated, the Address view is created in the Accounts table. In this view, the 

user can enter the addresses of clients, suppliers and members. 

Just as soon as these values have been confirmed, a new file is created using the parameters 

inserted. 

The user can thus create different accounting files, in different languages, and with different 

decimal points. In order to change the language or the decimal points once the accounting file has 

been created, the accounting type must be converted by selecting Convert to new file from the 

Tools menu. 
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2.2 Menu 

2.2.1 Favorite files 

This command allows the user to have the list of favorite files. 

To make a file Favorite: 

 Open the desired file 

 Click on Favorite files 

 Click on Add to list 

To edit the list of favorites, click on: 

 Favorite files 

 Edit list.. 

 In the window that appears, edit the favorites, by using the buttons: Add, Remove, Open 

folder. 

  

2.2.2 Recent files 

This command shows the list of recently used files and allows the user to empty the list when it 

becomes quite long. 
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2.3 Create Pdf dossier 

 

File Name 

In this area it is necessary to insert the name of the new file that the program will create to export 

the data. If, however, an existing file is selected by using the Browse button, the program will 

overwrite it with the new data. 

Display file immediately 

As soon as the Pdf file has been created, the software to view it will be launched. In this way, the 

result of the export can be seen immediately. It is best to remember that browsers like Mozilla and 

MS Explorer use a cache mechanism for files. When the export is made for a second time, it is 

possible that the user will see the previous version until the browser Reload button is pressed. 

Table creation options 

Headers 1, 2 and 3 

These are the table headers. 

Page options 

By activating the page options it is possibile to include: 

 page numbers 

 page progressive numbering 

 date 

Page size 

You can select the page format 
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Export selection only 

If this fonction is activated, only the selected area is exported. 

  

Other Tabs  

For the explanations of the other tabs, please visit the following pages: 

 Include 

 Period 

 VAT 

 Composition 

  

  

  

2.4 Save 

2.4.1 Making a security copy on a memory stick 

To make a security copy on the Memory Stick, open the file that is to be memorized; from the 

"File" menu, select the Save as command, and choose the unit that indicates the memory stick as 

destination. 

The copy can also be made by launching "Explorer" and by dragging the accounting file into the 

memory stick unit. 

  

2.4.2 Data recovery from the backup file 

When for one or another reason the user doesn't succeed to find the accounting file, one can retrieve 

the file from the backup copy that the program automatically executes.   

Proceed as follows: 

 open the directory where the accounting file was present.  

 open the file with the .bak extension. If it doesn't show in the directory, the user should, in 

the box "Files of type" in lower part of the window, select the option All files (*.*). 
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 Once opened, save the file with its name (save as...). Usually, the same name as the one of 

the lost file is being attributed. 
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2.4.3 Avoiding data loss 

The Banana accounting software automatically creates security copies (file name.ac2.bak). 

However, we strongly advise our users to create external backup copies in order to be able to 

resolve an eventual loss of data due to, for instance, a computer crash or another cause. 

There is free software on the market that allows the user to automatically create a backup for one's 

own data. 

2.5 File properties 

When a new file is created, the basic data need to be entered in the File Menu, using the File and 

accounting properties command. 

The file properties can vary depending on the chosen accounting type. 
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As the explanations of the different tabs vary depending on the chosen application, please visit the 

corresponding pages: 

 Double-entry accounting 

 Multi-currency accounting 

 Simple accounting - Cashbook 
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2.5.1 Password Tab 

 

The files can be protected by using a password. In this tab, the user can insert a new password by 

keying it in twice, the second time for confirmation. 

If the user wants to change an existing password, before entering the new password, he/she must 

first enter the old one. 

If the user wants to delete an existing password , enter the old password and leave blank the New 

password and Confirm new password fields. 

Note: using a password does not give a high level of protection. In order to render the data truly 

inaccessible to third parties, it is necessary to have the appropriate cryptographic software. 
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2.5.2 Text Tab 

 

In this tab it is possible to enter different key in order to save extra information, such as the 

accountant name, for example. 

Key 

In this field, input the reference text (e.g.: Address). 

Value 

In this field, it is necessary to input the value related to the key (e.g.: ). 

Add 

This button saves the new inserted data. 

Remove 

This button removes the selected Key. 
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2.5.3 Other Tab 

 

Current language 

There are some file texts that the program generates automatically, (e.g. the lines of the Totals table, 

the transactions on the account card, and the printout of the Enhanced balance sheet); in this tab, the 

user can indicate the language for these texts (usually the same as the creation language). 

Creation language 

This is the language chosen and selected when the user creates an accounting file; this language is 

used for the column headers. If the user wants to change the creation language, then it is necessary 

to convert the file to a new one using the Convert to new file command in the Tools menu. 

  

Related document: Convert to new file 
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3 Tables 

3.1 Cells 

3.1.1 Search 

 

Search text 

Enter the text to be searched. Amounts must be entered without separators. 

Options  

Whole words only 

If this box is activated, the program will find whole words only. For example, if the word being 

searched is Tot, it will not find Totals. 

Match case 

If this box is activated, the program will make a distinction between capital letters and small letters. 

Selected area only 

If this box is activated, the program will only search the information in the selected area. 

In order to begin the search, click on the Find button. The first piece of information corresponding 

to the request will be selected. To continue the search and find the next piece of information, select 

the Search next command from the Data menu, or else use the F3 key. 

  

3.1.2 Copy, cut and paste 

It is possible to copy/paste cells, rows or selected text just as it is possible to do with any normal 

Windows program: 

 Select the line or the area of data to be copied 

 In the Edit menu, select the Copy or Cut command 

 Move to the row or the area where the information should be copied 
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 From the Edit menu, select Paste 

The user can also copy/paste by using the following icons  or press Ctrl+C to copy 

and Ctrl+V to paste. 

  

3.1.3 Text imput, edit and Smart fill 

Entering a text 

In order to enter a text position yourself in the cell you wish to write in. With a double click on the 

cell a drop down menu will appear with all the text previously entered; as you start writing the 

program automatically suggest similar text previously entered; select the appropriate text and: 

 press Enter - in order to automatically enter the selected text 

 press the F6 key - in order to automatically enter the selected text + all other row data (debit 

account, credit account, amount, ...) 

  

Editing a text New! 

As a new feature of Banana Accounting 7, you can now edit the text directly in the cell; just double-

click the appropriate cell (or press the F2 key) and enter the new text. 

As you write the Smart fill option will assist you unless you disable it. 

As in the previous versions, it is also possible to edit a text selecting the cell and entering the new 

text in the text imput area. On the left side of this area there are two button to undo or accept the 

entered text. 

 

Entering an account number 
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Position yourserf in the Debit or Credit account column and start entering the account number or 

account description; the program will suggest you all the accounts with a similar number or 

description. Choose the appropriate one with the Down arrow key and press Enter. 

 

Attention: to deactivate last year's smart fill, you must deactivate the Smart fill with transactions 

from previous year option from the File and accounting properties command (Options tab - File 

menu). 

  

3.1.4 Rename  

 

This command allows the user to change the account or category number (accounts or categories 

table) and the VAT code (VAT Codes table), without having to enter the necessary modifications in 

the transactions. 

In order to rename, the user has to: 

 Position himself with the mouse on the cell that has to be changed (account/category 

number, VAT code) 

 Click on the Rename command in the Data menu.  

 Enter the new name in the appearing window 

Then, the software operates as follows (for example if you rename an account): 
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 verifies that there is no other account or group with the same number; if there is it the 

software will alert and ask if you want to proceed anyway. Please note that it is not possible 

to have to identical account numbers in the accounting plan. 

 verifies where the account to be renamed has been used and makes sure that the rows are not 

protected or blocked; if they are if will alert that the rename operation cannot be carried 

forward 

 substitues the account number wherever it has been used, in the tables and in the File 

properties, with the new account number 

The software does not recalculate any total, simply renames the account number. 

  

3.1.5 Replace 

 

The text to be searched and the text to be used as a replacement should be inserted in the same 

format as the one displayed in the input field. For example, the amounts should be inserted without 

the separator for the thousands. 

Search text 

Enter the text to be searched. 

Replace with 

Enter the replacement text. 

Options  

Whole words only 
If this box is activated, the program will find whole words only. For example, if the word being 

searched is Tot, it will not find Totals. 

Match case 

If this box is activated, the program will make a distinction between capital letters and small letters. 

Selected area only 

If this box is activated, the program will only search the information in the selected area. 
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Replace all 

This key will replace the desired data throughout the whole document at once. 

Replace 

This key will replace one data at a time. 

Find next 

This key begins the search of the data one by one. If the data in search is not present, the "Text not 

found" message will appear. 

  

3.1.6 Wrap text 

When the text for a row is very long, the Calculate row height command from the Format menu 

allows the user to view it completely, adapting the height of the row. 

To adapt the height of the row to the text, the user should: 

 Choose the Columns setup command from the Data menu 

 Select the appropriate field name 

 Activate the option Wrap text in the Display tab 

 Recall the Calculate row height command each time it is necessary.  

The Calculate all row heights command is equal to the one described above, with the difference 

that it operates on all rows of the table.  

  

3.2 Columns and views 

3.2.1 Columns setup 

Display Tab  
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Header 

This is the column header. 

Header 2 

This header is used by the program for only a few fields (e.g. Amount column). 

Description 

This is the description of the field. This description will be shown as a tooltip. 

Format 

This is the format to show numbers, date and time (see chapter at the end of this page). 

Width 

This section defines the horizontal size of the column. 

Column Style 

This is a drop-down menu that indicates the style to be used (Format, menu, see sub chapters). This 

style has priority over the style of the row. 

Alignment 

The user can choose whether to align the text right, left or center in this drop-down menu. 

Wrap text 

This option allows the user to view the input text on more than one line. 
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Protected 

This option allows the user to protect the entire column so that no data can be input or edited. 

Exclude from printing 

When this option is activated, the field will be excluded from printing. 

Visible 

This option allows the user to make column visible. 

The tables can be altered. Fields can be added, headers can be changed, and column sizes and the 

order in which they are shown can be altered. 

Move up, Move down 

The fields are listed in the order in which they appear on the table being used. The visible fields are 

the ones with a checkmark. 

In order to alter the order in which they appear simply select the field you wish to move and drag it 

up or down. 

Add 

This button adds new fields (columns) to the current table. Field added by the user are just 

information fields; the program does not make any calculation on numeric data. 

Delete 

This function is used to delete a field (column) from the list. A system field, however, cannot be 

deleted. 

  

Settings Tab  
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Field name 

This is the name of the active field and it is automatically inserted by the program. It cannot be 

modified. 

Field name Xml 

This is the name of the active field in the Xml format and it is automatically inserted by the 

program. It cannot be modified. 

Data type 

It is possible to choose between the following predefined types: Text, Number, Amount, Date, 

Time. 

Max and Min lenght 

Maximun and mInimum field lenght. 

Max and Min Value 

It is possible to enter minimum and maximum values (numbers or caracthers). 

Decimal points 

It is possible to define the field decimal points 

Field number 

This is a number automatically given to the field, and has uniquely a technical purpose. 
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All caps 

By clicking this options all fields data will be shown in caps characters. 

  

Date, hour and number format  

When the format is modified, the way the date, time and numbers are shown, changes.  

If no specific format is specified, the default Windows format will be used (date, time and numbers 

indicated on the control panel). 

In the Format area of the Set up fields/Edit attributes command    (Data menu) the user can use 

other formats. Types of formats, with some examples, are listed below: 

  

Format date Examples for date 

d mm yy 1 01 11 

dd m yy 01 1 11 

ddd mmm yyyy Fri Jan 2011 

dddd mmmm yyyy Friday January 2011 

The letter “d” (day) indicates the day, the “m” (month) indicates the 

month, and the “y” (year) indicates the year. 

  

Format time Examples for time 

hh:mm:ss:zzz  04:04:36:089 

h:m:ss:zz  4:4:36:89 

Naturally the user can also invert the order of the elements making up 

the date or the time as desired (e.g.: mm dd yyyy). 

As far as the separators are concerned, the user can choose between all 

of those available on the keyboard (for example:"#2141_, @, -, /, ., 

etc.). 

  

Format numbers Example for numbers 

0.  259 

0.00  258.85 

0.000  258.848 

The number of decimal spaces in a number field can be edited 

according to the user’s needs. Actual calculations are made using all 

the inserted decimal numbers. Rounding is only done for what is shown 

on screen.  
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3.2.2 Views setup 

 

Settings  

Views can be edited: fields can be added, headers can be changed, columns width can be varied... 

Name 

It is possible to enter a new name for the selected view. 

Xml name 

This is the field name for the Xml export. For system views this name cannot be changed. 

Visible 

When selecting this checkbox the view will be visible. 

System 

If this checkbox is selected the view is a system view and cannot be deleted or edited. 

Columns setup... 

This button shows the fields list. 

Page setup... 

This button leads to the page format settings. 

Add... 

This button adds a new view to the list. Once it has been added the user can alter the field attributes. 

Delete... 

This button deletes a view from the list. System views cannot be deleted. 
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3.2.3 Customizing the views 

The views can be customized, with regard to the way the columns are shown, as well as modified 

where it concerns the number of views. 

In the first case the desired columns can be inserted or cancelled, even if they appear in other views, 

through the Fields setup command in the Data menu. 

In the second case, if a view is not needed and the user doesn't want it to be shown, it is possible to 

make it invisible through the Views setup command in the Data menu. 

New views can also be added, but only for information, according to the data entered by the user 

and they are not processed by the software. 

 

3.2.4 Short-cut keys 

3.3 Rows format 

In the Format menu the following commands are present: 

Default style 

There is a default style for the whole file. When a new row is added, the default style is used. 

Points 

Use different points to define the font dimensions. 

Bold and Italic 
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Modify default style 

To change the default style: 

 Attribute the desired style to a row 

 Select the Modify default style command from the Format menu 

All the rows with the original default style will then be shown in the new default style. 

Calculate row height 

When the text for a row is very long, the Calculate row height command from the Format menu 

allows the user to view it completely, adapting the height of the row. Activate this function on 

condition that, in the field attributes (Data menu, Set up fields command – Edit attributes button), 

the Wrap text option has been selected.  

Calculate all row heights 

This command operates in the same way as the previous command except that it works on all the 

rows in a table instead of only one. 

Page break 

At any point in a file, the user can insert a page break 

To insert a page break: 

 Place the cursor on the first row where the new page is to be created 

 Open the Format menu 

 Select the Page break command 

To remove a page break: 

 Place the cursor on the row with the page break 

 Open the Format menu 

 Select the Page break command again 

  

3.3.1 Page break 

At any point in a file, the user can insert a page break 

  

To insert a page break: 

 Place the cursor on the first row where the new page is to be created 

 Open the Format menu 

 Select the Page break command 

To remove a page break: 

 Place the cursor on the row with the page break 

 Open the Format menu 

 Deactivate the Page break command  
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3.4 Page setup 

 

Header left 

This is where the title for the current view is shown. The title can be edited to appear at the top left 

of the printed page. 

Header right 

It is possible to insert a different text that will be printed at the top right-hand side of the page. 

Margins  

It is possible to input the page margins here. Measurements are in centimeters. 

Include in print  

File Header 

This will be the text inserted in the File and Accounting properties found in the File menu. 
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Table Header 

This is the text input in the Page setup window in the File menu (Header left and right). 

Auto text 

This is the text automatically attributed to the table by the program. This text cannot be edited by 

the user. For example, if the cash account card is being printed, then "Account Card: CASH" will be 

printed. 

Column headers 

These are the headers for the various table columns. 

Large font 

The program prints the headers using a slightly larger font. 

Page break 

When activated, this option maintains the inserted page breaks; if not, they will be ignored, even if 

they are present. 

Page numbers 

Activate this option to request that the pages be numbered. 

Print time 

Activate this option to include the hour when the page was printed. 

Print date 

Activate this option to include the date when the page was printed. 

Row number 

Activate this option if a progressive number is to be given to each row. 

Grid 

The grid can be printed just as it is viewed on screen. 

Zoom  

Zoom % 

This allows the increase or decrease, on a percentage basis, of the size of the font to be printed. 

Reduce to page width 

If some columns exceed the width of the page, the program reduces (reduces the zoom) the printing 

so that all the columns will be printed correctly on the page. 

As on screen 

The print-out will be carried out exactly as presented on the screen. 

Print landscape 

To print in landscape format which makes the page read horizontal. 
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3.5 Rows 

3.5.1 Adding and deleting rows 

To insert blank rows below the selected row, follow these steps: 

 Move the cursor above the row where additional rows need to be inserted  

 From the Edit menu, select the Add rows command 

 In the window that appears, key in the number of rows to insert 

 Confirm by clicking on OK 

  

There is still another procedure to add blank rows: 

 Move the cursor above the row where additional rows need to be inserted 

Click on the following icon  on the Tool bar, one time for each row that you want to add. This 

procedure is advised when the amount of rows to be added is rather limited. The sequence for 

the shortcut key is: Ctrl+Enter. 

  

To insert blank rows above the selected row, follow these steps: 

 Move the cursor below the row where additional rows need to be inserted 

 From the Edit menu, select the Insert rows command 

 In the window that appears, key in the number of rows to insert 

 Confirm by clicking on OK. 

In order to delete one or more rows, select the row or rows that need to be deleted and from the Edit 

menu, click on the Delete rows command. 

  

3.5.2 Protecting the rows 

Using the Protect rows command, from the Edit menu, the user activates row protection to avoid 

making any changes by mistake.  

The protected rows cannot be edited until, by using the Unprotect rows command, the protection is 

being removed.  

  

To put protection into effect: 

 Select the desired row(s) to protect 

 From the Edit menu, select the Protect rows command 
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 Confirm the number of rows to be protected by clicking on OK. 

Protected rows have light grey row numbers. In order to edit them again, first remove the protection 

by the Unprotect rows command in the Edit menu.  

  

3.5.3 Go to 

 

Select the Go to... command from the Data menu to open a window allowing the user to move to a 

desired row. When a selection table is active (for example, an account card), by using the Go to 

original row command, the program automatically takes the user to the corresponding row of the 

Transactions table. 

  

3.5.4 Extract rows 

 

All rows 

All rows of the active table will be extracted. 

Filter by value 

When this option is activated, the rows are being extracted according to the selected column, the 

condition and the inserted value. 
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Column 

The column, that contains the rows to be extracted, is being selected. 

Condition 

This list contains all the conditions needed in order to select the rows to extract: = equal to, < less 

than, > greater than, <> different, <= less or equal, >= greater or equal, contains text, does not 

contain the text, blank, not blank. 

Value 

In this field, insert text to be compared to the condition. For example, the condition is (=) equal to, 

and the user inserts as comparison value  03.01.2012, the program will extract all entries made on 

January 3th 2012. 

The text is a date if the field selected is a Date, a numerical value if the field is an Amount, a word 

if the field is a Description. 

Match case 

If this box is activated, the program will make a distinction between capital letters and small letters. 

Invert result 

If this option is activated, the program will select rows using the opposite of the criteria desired in 

the condition field. For example, if selecting, as a condition, all the rows with a date > 01/03/2012 

and activating the Invert result cell, the program will extract all the rows with a date <= 01/03/2012. 

Selected rows 

Only the selected rows will be extracted. 

  

3.5.5 Sort rows 

 

The rows on the table can be sorted according to the content of the columns. First of all, define the 

fields to use as a sorting key. 

 

First key, Second key, Third key 
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There are three areas where the keys can be input and each one contains a list of columns names 

from the current table. Choose how to sort each key. If the columns only contain numbers, then 

choose the Number option. 

Sort selected rows only 

This option is only available when rows have been pre-selected. If activated, only the selected rows 

will be sorted. 

  

4 General 

4.1 Main interface 

When a new file is being created or an existing one is opened, the software presents a structure that 

is characterized by the following elements 
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4.2 Composition 

The Composition tab allows to save different setups, that can be used at a later date. 

How to obtain Compositions  

Compositions can been obtained mainly through the Account1 menu when it is about the Enhanced 

Balance sheet, the Enhanced Balance sheet with groups, the Reports and the VAT report, and from 

the File menu for the compositions concerning Create Pdf dossier and Export file.  

Once the document to be created has been chosen, click on Default; continue selecting the 

appropriate settings and in order to save the configuration, go to the Composition tab and save 

under a new name. 

 

Name 

Enter a name to identify the composition (for instance, Quarterly Report). 

Description 

Enter the description for the composition. 

Open settings dialog 

If activated (default), when selecting a composition from the menu, the dialogue for editing the 

settings will be shown. If not activated, the preview of the requested report (Balance sheet, report, 

etc.) will be shown directly. 
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Read only 

If this option is activated, it will not be possible to edit the settings. 

Reset 

This function allows to reset a composition with the default settings. If you want to restore the 

earlier settings, and cancel the last edited settings, use the Undo command from the Edit menu.  

  

Each created composition appears in the menu of the corresponding command and can be modified, 

renamed, duplicated or deleted with the Manage compositions command of the Account1 menu. 

  

4.2.1 Manage compositions  

Composition menu  

In the menu, the saved compositions are being displayed, the default composition and the Manage 

compositions command. 

 

Default  

This is the default composition that the program uses in case no other composition has yet been 

created. 

The default composition is also the one being used when the fonction gets called upon directly from 

a table (for example, when one is positioned on the VAT code column and one clicks on the small 

blue arrow in order to generate the VAT Report). 

  

Manage compositions  

This dialogue allows the user to edit, delete, duplicate, rename or create compositions. 
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Edit... 

This button allows the user to edit the selected composition's settings. 

Delete... 

The selected composition is being deleted. 

Duplicate... 

A new composition is being created by duplicating the selected one, with the possibility to edit the 

settings. 

Rename... 

The name of the composition is being changed. 

New 

A new composition is created with the basic settings. 

Open 

The composition is being executed and the report is being displayed. 

  

Direct acces to the compositions  

In the tables where the compositions are being displayed and in the previews, the composition menu 

and the settings icon are available, in order to easily move from one composition to another and to 

have quick access to the settings in case any changes are to be made.  
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4.3 Period 

This tab appears in many dialogs (for example the Account card) and can specify the period to be 

show or to be calculated. 

If for example a quarter is selected: in the account card only the transactions of the selected quarter 

will be shown, and in the balance sheet only the results for the selected quarter will be calculated. 

 

All 

If this option is selected, the entire accounting period is included. 

Period selected 

If a specified period is desired, indicate the start and end dates. 
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Transactions with no date 

If there are transactions with no date, they will be considered only if you chose the whole period 

(All...) 

If however you enter the initial and final dates January 1sr and December 31, the transactions with 

no date will not be included in the report. 

  

4.4 Export 

With Banana accounting you can export in different formats, either the data of a single table of the 

whole file: 

Export rows 

Choose the Export rows command from the Data menu in order to export the content of a single 

table. 

If you select some rows before launching the command, then the Export selection only option will 

be activated. 

Export file 

Chose the Export file command from the File menu in order to export more than one table. In the 

dialog windows that appears you will find the following tabs: 

 Specific tabs of the exporting format 

 Include tab, to define the tables and the reports that must be included in the export 

 Period (Accounting) tab, to define the period 

 VAT tab (in the accounting files with VAT management) 

 Composition tab 

Export formats 

There are different formats available, each with its own specific options: 

 Pdf 

This format allows to export all accounting file content in a unique pdf file. 

 Excel 

This format allows to create Excel spread sheets, comparisons, budgets, index calculations, 

Balance Sheet analysis, charts directly linked to accounting values. 

 HTML 

With this format the data and accounting statements can be easily accessed with an Internet 

browser (Explorer, Mozilla, Opera). 

This format fully complies with the legal requirements related to long-term archiving of 

accounting data. 

 XML 

This format is the standard used for exchanging data. The accounting data can be easily read 

and reused with other programs or with XSLT style sheets. 

 Export rows in TXT 

This format allows to export the table rows in a text format. 
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4.4.1 Include Tab 

 

Recheck accounting 

By ticking this box, the accounting will be rechecked before it is exported. 

Include  

By ticking the different boxes, the user can export in MS Excel Xml the various tables and/or all the 

account cards and the VAT/Sales tax Report. 

View 

It is possible to select the view where the data are to be imported. This option is only available on 

the export in Html and Xml format. 

Periods  

This function lets the user export the accounting data subdivided by period. 

Accounts/Categories by period 

This option allows to export the accounts and categories balances according to the selected period. 

VAT/Sales tax report 

This option allows to export the VAT/Sales tax report according to the selected period. 

Create periods for the whole year 

By selecting this function, the partial balances for the whole year will be exported, and not only the 

ones of the specified accounting period or the selected export period. 
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Max number of periods 

The maximum possible number of periods. 

  

4.4.2 Export in Excel 

 

Export selection only 

When activating this option, the program exports only the selected area. 

File Name 

In this area it is necessary to insert the name of the new file that the program will create to export 

the data. If, however, an existing file is selected by using the Browse button, the program will 

overwrite it with the new data. 

Display file immediately 
As soon as the MS Excel file has been created, the software to view it will be launched. In this way, 

the result of the export can be seen immediately. 

Options 

Create cell names 

This option will automatically give a name to each cell as the file is exported. For example, the cell 

that contains the balance for account 1000 will receive the name: "Accounts_1000_Balance" in 

Excel. This means the user can univocally identify each cell independently from its position on the 

sheet and thus create Excel reports that don't have to be corrected if the account plan is changed. 

The user thus saves having to manually carry forward any accounting data to Excel. However, 

inserting the names of the cells does slow down the opening of the Excel file. 



58 

B A N A N A  A C C O U N T I N G  

Create table names 

With this option, the program will automatically give a name to the whole area of the cells 

belonging to a table, at the moment the file is exported. For example, the area formed by the cells 

belonging to the Accounts table will be identified by the name DB_Accounts. This option is 

necessary if, when creating reports in Excel, database functions are used. 

Use names Xml (English) 

The cell names can either be defined in their original accounting language, or with their English 

name. In the original language, the names will be understandable to someone who speaks that 

language, but they will not be universally understood like a name in English would be. By selecting 

this option the user would have, for example, "Accounts_1000_Balance" instead of 

"Conti_1000_Saldo". 

Protect tables 

The entire content of cells is locked when selecting this option so that it is only possible to edit the 

format. This prevents the possibility of making any unintentional changes to the exported data. The 

user can remove this protection at any time by using the appropriate command in Excel. 

Export selection only 

If this cell il activated, only the selected area is exported. 

Other Tabs  

For the explanations of the other tabs, please visit the following pages: 

 Include 

 Period 

 VAT 

 Composition 
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4.4.3 Export in Html 

 

File Name 

In this area, the user must insert the name of the new Html file that the program will create to export 

the data. If however the user selects an existing file through the Browse button, the program will 

overwrite it with the new data. 

Display file immediately 

As soon as the Html file has been created, the software to view it will be launched. In this way, the 

result of the export can be seen immediately. It is best to remember that browsers like Mozilla and 

MS Explorer use a cache mechanism for files. When the export is made for a second time, it is 

possible that the user will see the previous version until the browser Reload button is pressed. 

Table creation options  

Headers 1, 2 and 3 

These are the table headers. 

Export selection only 

If this option is checked, only the selected area will be exported. 

Other Tabs  

For the explanations of the other tabs, please visit the following pages: 

 Include 

 Period 

 VAT 

 Composition 
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4.4.3.1 Html Options Tab 

 

Use style sheet CSS 

Selecting this cell will allow the user to connect a style sheet to the exported file. By default the 

program will automatically use its own style sheets and incorporate it into the document. 

Use predefined style sheet 

The program's default style sheet will be used. 

Deactivating the cell will automatically activate the External style sheet option. The user can then 

select the name of a personal style sheet. 

External style sheet  

In case an external style sheet is being used, select the file name of the style sheet with the Browse 

button. 

Include style sheet within html file 

When data is sent in Html format, the style sheet file must also be sent. To avoid sending two 

separate files the user can incorporate the style sheet to the Html accounting file by activating this 

cell. 

 

Selecting the cells will allow the program to file the data with various graphic options: 

 Export visible columns only 

 Table with border 

 Columns with headers 
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 Preserve page breaks within the table 

If there are page breaks on the original accounting file, these will be carried over in the 

export as well. 

 Export as data - data will be exported witout any formatting 

Other Tabs  

For the explanations of the other tabs, please visit the following pages: 

 Include 

 Period 

 VAT 

 Composition 

  

4.4.4 Export in Xml 

 

File Name 

In this area it is necessary to insert the name of the new file that the program will create to export 

the data. If, however, an existing file is selected by using the Browse button, the program will 

overwrite it with the new data. 

Display file immediately 

As soon as the file has been created, the software to view it will be launched. In this way, the result 

of the export can be seen immediately. 

Style sheet XSLT 

In this area, the user can select the style sheet according to which the program should organize the 
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graphic display of the accounting data. Thanks to the style sheets, the user can input his/her own 

data and conform to the print-outs required by the authorities. On the www.banana.ch various 

examples and further information on style sheets are available. 

Options  

It is possible to choose between the following options: 

 Export visible columns only 

 Include view list 

Export selection only 

If this option is activated, only the selected area will be exported. 

Other Tabs  

For the explanations of the other tabs, please visit the following pages: 

 Include 

 Period 

 VAT 

 Composition 

  

4.4.5 Export rows in txt 

 

File name 

Enter the file name. 

Format 

Select the desided format. 

Options  

http://www.banana.ch/
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If activated options will allow the export of: 

 Selected rows only 

 Visible columns only 

 Columns header 

 Unicode (Utf-8) 

  

4.5 Keyboard shortcuts 

You can consult the list of keyboard shortcuts by choosing Keyboard shortcuts from the Help 

menu.  

  

4.6 Import 

4.6.1 Import into accounting  

In order to import the data from other Banana files, from a bank statement and from a text file, 

execute the Import to accounting command from the Account1 menu. 

Next, select the desired import type (Import transactions, Import accounts, import VAT codes and 

Import exchange rates), and select the file of which the data have to be imported with the Browse 

button.   

The transactions of different kind of files can be imported: Cash book, Simple accounting, Double-

entry accounting, in  *.ac2  format. 

It is also possible to import the transactions of a bank or postal account statement in the formats that 

are indicated in the dialogue window: MT 940, ISO20022 and  .txt receipts/payments transactions 

or from a  text file with column headers (*.txt). 

It is possible to update the list of formats or to add new ones with the Manage filters command. 
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Frequently asked questions: 

I don't see the format for the bank statement of my bank 

Click on "Manage filters...", then on "Update filters" and enable the filter for the desired format. 

I don't see the format for the Postfinance xml statement (files .tgz) 

This format is no longer supported. Please contact Postfinance and ask to receive the account 

statement in ISO 20022 format. 

The error message 'This ISO 20022 file does not contain a bank statement (camt. 053)' is 

displayed 

This error message is displayed if the ISO 20022 file does not contain a bank statement. The ISO 

20022 format is a generic format that can contain different types of information, such as a bank 

statement and execution confirmation. In Banana Accounting, only bank statements can be 

imported (camt. 053). 

My bank is not in the list of supported formats 

It is possible to create new filters for formats that have not yet been implemented. Our support 

services are also available to help implement customized formats (there is a charge for this type of 

support). 

  

Can be imported as well: the Accounts, the VAT codes and the Exchange rates from another 

Banana file. 
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Related document: Import rows 

  

4.6.1.1 Manage filters 

Filters are extensions that make it possible to add new formats to the  "Import into accounting" 

dialog. 

  

 

  

Enable 

Enables the selected filter and makes it visible in the "Import into accounting" dialog. 

Disable 

Disables the selected filter. A disabled filter cannot be seen in the "Import into accounting" dialog.  

Deletes 

Permanently deletes the selected filter. It is not possible to delete files that are installed at the 

system level or that are for all users. 

Import... 

Makes it possible to add a filter. 

Update filters 

Allows the user to update the filters by downloading the most recent version from Banana 

Accounting's server. If there are now filters, they will be added to the list. The imported filters will 
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not be modified. 

  

Important: 

The filters will be installed in the user folder. Thus only the user who imported the new filters or 

updated the available filters will see them. To install filters for all users or at a system level, a 

manual procedure for installing the filters would need to be followed.  

When moving with the cursor over the filter, a box will appear, indicating the id, installation folder, 

version and date of the filter. 

  

  

4.6.1.1.1 Extending Banana Accounting 7 

Index  

Introduction 

Location of filters 

The content of a filter's file 

Filter's attributes 

Exec() function 

Javascript filter's API 

Banana namespace 

Application object 

Converter object 

Document object 

Table object 

Row object 

Tutorials 

Changelog 

  Introduction  
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Disclaimer: This functionality is in developement, the specifications may be changed at any time, 

with or without notice. 

  

In Banana Accounting 7 it is possible to extend some of the functionalities though litte javascript 

programs. Precisely you can: 

 Add new import formats: 

For example you want to import a txt file that your invoice program export; 

  

 Define complex check routines: 

For example you want to test all transactions for a particular condition; You can show the 

rows that didn't meet it in a table, or display a message with detailed informations to the 

user; 

  

 Export data in a custom format: 

For example you want to export the balances of some accounts in a format ready to be 

published on internet or inserted in other documents; 

Those JavaScript programs are called filters. 

  

For a practical quick introduction jump to the tutorials or read further for the specifications. 

  

Location of filters  

Filters are files with extention ".js" and can be placed in various folders. Where they are placed 

determine who can see and use them: 

Windows Path 

Current user C:\Users\{user_name}\AppData\Local\Banana.ch\Banana\7.0\Filters 

All users C:\ProgramData\Banana.ch\Banana\7.0\Filters 

All users (network 

installation) 
C:\Programs\Banana70\Filters 

    

Apple Path 

Current user ~/Library/Application Support/Banana.ch/Banana/7.0/Filters 

All users /Library/Application Support/Banana.ch/Banana/7.0/Filters 

All users (network 

installation) 
/Applications/Banana 7.app/Contents/Resources/Filters 
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Linux   

Current user ~/.local/share/data/Banana.ch/Banana/7.0/Filters 

All users   

All users (network 

installation) 
/usr/local/Banana7/Filters 

  

The order in which the filters are loaded is: application folder, all user folder and user folder. If a 

filter is defined twice, only the first occurence is loaded. For example a filter located in the 

application folder has priority over a filter located in the user folder. 

  

The content of a filter's file  

The file .js follow the JavaScript syntax. It has to contain some filter's attribures, inserted through 

tags in comment's lines at the beginning of the file, and to define the function "function 

exec(string)". Tags give informations about the filter, like it pourpose. The function "exec()" is the 

function that is called by the program to execute the filter functionality. 

Example:  

// @id = ch.banana.filter.import.bank 

// @version = 1.0 

// @pubdate = 2012-09-10 

// @publisher = Banana.ch SA 

// @description = Bank statement (*.csv) 

// @description.de = Bankkontoauszug (*.csv) 

// @task = import.transactions 

// @outputformat = transactions.simple 

// @inputdatasource = openfiledialog 

// @encoding = utf-8 

// @inputfilefilter = Text files (*.txt *.csv);;All files (*.*) 

// @inputfilefilter.de = Text-Datei (*.txt *.csv);;Alle Dateien(*.*) 

 

/** 

 * Parse the data and return the data to be imported as a tab separated file. 

 */ 

function exec(string) { 

    var transactions = Banana.Converter.csvToTable(string, ';', '"'); 

 

    // ... csvToTable convert a csv file to an array of array (line and columns) 

    // ... do some processing and return it as tab separated values 

 

    return Banana.Converter.tableToTsv( header.concat(transactions)); 

} 
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For a complete example take a look at the tutorial: Create a new filter to import custom csv data 

  

Filter's attributes  

With tags you tell the program the pourpose (import, export, extract, ...), the name displayed in the 

dialogs, the kind of data it expect to receive, the kind of data it returns, and other informations about 

the filter. Tags are inserted in comment's lines though the following syntax: "// @tag-name = tag-

value". 

  

Tag Content Description 

@id Identification in form of reversed 

Internet domain name 

Ex.: ch.banana.filter.import.bbank 

If two filter have the same id only 

the first one is loaded. The order in 

which the filters are loaded is: 

application folder, all user folder and 

user folder. 

@version Version of the filter This is used to check if newer 

version of the script exist. This apply 

only to the filters published by 

Banana.ch. 

@pubdate The publication date in the format 

YYYY-MM-DD 

  

@publisher The publisher of the script   

@description[.lang] The name or description of the filter This text will be displayed in the 

dialogs. 

This tag is localisable. 

@task One of following values: 

import.rows 

import.transactions 

import.accounts 

import.categories 

import.exchangerates 

import.vatcodes 

export.file 

export.rows 

export.transactions 

extract 

This value define the pourpouse of 

the filter, and determine in which 

dialog or menu the filter is visible. 

@outputformat One of the follwing values: 

tablewithheaders 

transactions.simple 

If the filter has an import tasks this 

value define the format of the 

returned value. The format 

transaction.simple contains the 

transaction as income / expenses. 
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@exportfiletype A strind defining the type of data 

exported 

txt 

... 

  

This parameter is used for export 

filters, it defines the type of exported 

data and it is used for the extention 

in the save file dialog. 

@inputdatasource One of the follwing values: 

none 

openfiledialog 

fixedfilepath 
1)

 

With this attibute you can specify if 

you dont' need input data, if you 

want that the user select a file to 

import (openfiledialog), or if you 

want to get a file which path is 

defined in @inputfilepath. If you set 

fixedfilepath the program will ask 

the user the permission to open this 

file, the user's answer will be saved 

for the next execution. 

@inputfilefilter[.lang] The filter for the open file dialog 

Ex.: Text files (*.txt *.csv);;All files 

(*.*) 

This value describes the file filters 

you want to show in the input file 

dialog. If you need multiple filters, 

separate them with ';;' for instance. 

This tag is localisable. 

@inputfilepath The file to read for the input data If the filter has the value 

fixedfilepath as @inputdatasource, 

you can define here the path of the 

file to load. 

@encoding The encoding of the input data. 

One of the following values: 

latin1 

utf-8 

iso 8859-1 to 10 

... 

The encoding to use to read the input 

file. 

For a complete list see QTextCodec 

@timeout The timeout for the script in 

milliseconds, default is 2000 (2 

seconds). If you set -1 the timeout is 

disabled and the application allow 

you to abort it though a progress bar. 

If the script take longer tham this 

value to finish, it will be aborted and 

a message showed. If you have a 

script with a very long run time, you 

can increase the timeout. 

Default values are listed in bold. 

1) Function not available yet 

  

The exec() function  

http://qt-project.org/doc/qt-4.8/QTextCodec.html
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The function exec() is called every time you execute the filter. It has one argument, the requested 

input data as string. The result is returned also as a string. The format of the returned string have to 

match the tag @outputformat for import filter, for other tasks the format is not determined. Errors 

are notified through exceptions (clause throw), or just by returning a string beginning with 

"@Error:". 

The script is ECMA-262 compliant. For a list of supported functions, objects and properties see: 

http://qt-project.org/doc/qt-4.8/ecmascript.html 

The script global environement provides a collection of predefined objects that the Javascript 

program can reference in order to interact with Banana Accounting. Those objects are: 

"Banana.application", "Banana.Converter" and "Banana.document". 

The object "Banana.application" represent the running application. 

The object "Banana.Converter" is just a collection of methods to convert various file formats to and 

from data tables (array of array). Arrays are in Javascript very powefull and by writing just a 

function you can sort, filter and map them. See Complete Array object reference on w3school.com. 

The object "Banana.document" represent the current opened document and it enables to access the 

tables and informations stored in it. 

  

JavaScript API for Banana Banana namespace Objects  

Banana.application This object represent the running application. 

Banana.document This object represent the current opened document in the application. 

Banana.Converter This object is a collection of method to convert data from and to various 

formats. 

  Application object Properties  

version Return the version of the application in the form of "7.0.1.0". 

Introduced in 7.0.2.0 

locale Return the locale of the application in the form of "language_country", where 

language is a lowercase, two-letter ISO 639 language code, and country is an 

uppercase, two- or three-letter ISO 3166 country code. 

Introduced in 7.0.2.0 

progressBar Return an object of type ProgressBar used to give the user an indication of the 

progress of an operation and the ability to cancel it. 

Introduced in 7.0.2.0 

  ProgressBar object Methods  

start(maxSteps) Start the progress indicator and define the number of steps this operation needs 

before to be completet. You can call several time this method to split the progress 

in main and sub steps. Every call of the method start() should be paired with a call 

http://www.ecma-international.org/publications/standards/Ecma-262.htm
http://qt-project.org/doc/qt-4.8/ecmascript.html
http://www.w3schools.com/jsref/jsref_obj_array.asp
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of the method finish(). 

Example: 

var progressBar = Banana.application.progressBar; 

progressBar.start(3);           // Three main steps in script 

progressBar.start(rowCount)     // Main step 1 has rowCount steps 

for (i=0;i < rowCount; i++) { 

   ... 

     if (!progressBar.step(1)) 

      return;                   // Cancel execution 

} 

progressBar.finish();                         // Main step 1 completed 

...                                           // Main step 2 doesn't have sub steps 

progressBar.step(1);                           // Main step 2 completed 

progressBar.start(10)           // Main step 3 has 10 steps 

for (i=0;i<10;i++) { 

   ... 

     if (!progressBar.step(1)) 

      return;                   // Cancel execution 

} 

progressBar.finish();                         // Main step 3 and script completed 

Introduced in 7.0.2.0 

step(stepCount) Advance the progress indicator of stepCount steps. 

This method returns false if the user canceled the operation, otherwise true. 

Introduced in 7.0.2.0 

finish() Notify that the operation has been completed and advance one step. 

Introduced in 7.0.2.0 

  Converter object  

The "Banana.Converter" object is just a collection of statics methods usefull to convert various file 

formats to and from data tables (array of array). 

Methods  

stringToLines(string) Convert a text in an array of lines. 

csvToTable(string,separator,textdelim) Convert a csv (coma separated values) file to a table (array 

of array). 

The paramenter string contains the text to convert. The 

parameter separator specify the character that separates the 

values, default is a comma ','. The parameter textDelim 

specify the the delimeter character for text values, default 

is a double quote '"'. 
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Example: 

var text = "1, 2, 3\n4, 5, 6\n7, 8, 9"; 

var table = Banana.Converter.csvToTable(text); 

var value = table[0][1]; 

value == '2'; // true 

flvToTable(string,fieldLenghts) Connvert flv (fixed lenght values) file to a table (array of 

array). 

The paramenter string contains the text to convert. The 

parameter fieldLienghts is an array with the lenghts of the 

fields. 

Example: 

//               6                                          20                 8 

var text = "120608Phone               00002345"; 

var table = Banana.Converter.flvToTable(text, [6,20,8]); 

var value = table[0][2]; 

value == '00002345'; // true 

mt940ToTable(string) Converts mt940 file to a table (array of array). 

stringToCamelCase(string) Converts a text to camel case, where the first letter every 

word is upper case. 

stringToTitleCase(string) Converts a text to camel case, where the first letter of the 

text is upper case. 

tableToTsv(string) Converts a table (array of array) to a tsv (tabulator 

separated values) file. 

tableToCsv(string, defaultChar) Converts a table (array of array) to a tsv (coma separated 

values) file. If a string contains a tab it will be replaced 

with defaultChar or a space if not defined. 

Parameter defaultChar introduced in 7.0.2.0 

arrayToFormattedString(array) Converts an array or a table to a readable string. 

Example of a formatted string: 

[ 

   [ 

      20120910 

      Text 

      1234.56 

   ] 

   [ 

      20120911 

      Text 2 

      2345.67 
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   ] 

   ... 

] 

toInternalAmountFormat(string) Converts an amount to the internal format: 123456.78. The 

internal amout format use the character '.' as decimal 

separator, and doesn't contain a group separator. 

toInternalNumberFormat(string) Converts a number to the internal format: 123456.78.The 

internal number format use the character '.' as decimal 

separator, and doesn't contain a group separator. 

toInternalDateFormat(string) Converts a date to the internal format: YYYYMMDD. 

toInternalTimeFormat(string) Converts a time to the internal format: HH:MM. 

  

Document object  

This object represent the current opened document in Banana Accounting. 

Properties  

isValid Return false if no document is opened, otherwise true. 

locale Return the locale of the application in the form of "language_country", where 

language is a lowercase, two-letter ISO 639 language code, and country is an 

uppercase, two- or three-letter ISO 3166 country code. 

Introduced in 7.0.2.0 

tables Return the xml names of the visible tables as an array. 

selectedTable Return the xml name of the current selected table. 

Methods  

addMessage(msg) Add the message msg to the qeue of the document. If in the 

application the Option "Show Messages" is turned on, a 

dialog is show to the user. The message is in any case 

showed in the pane "Messages". 

Introduced in 7.0.2.0 

info(section,id) Return the value of the document referenced by section and 

id as string. Section and Id correspond at the xml name 

listed in the Info table: see command "File info" in menu 

"Tools". 

table(tableMame) Return the table referenced by the name tableName as a 

Table object, or an invalid Table object if it doesn't exist. 

value(tableName,rowNr,columnName) Return the value in the table tableName, row rowNr and 

column columnName as string. If the table, row or column 

are not founds it return an object of type invalid. 
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Methods for accounting's files  

accountsReport(param) Return the account report for the specified perdiod. 

param = { 

  startDate : 'YYYYMMDD',   // Start date 

  endDate: 'YYYYMMDD'       // End date 

}; 

Introduced in 7.0.2.0 

vatReport(param) Return the vat report with tfor the specified perdiod. 

param = { 

  startDate : 'YYYYMMDD',   // Start date 

  endDate: 'YYYYMMDD'       // End date 

}; 

Introduced in 7.0.2.0 

journal(param) Return the journal. In the journal every transaction is break down to one or 

more entries, where each entry is debiting or crediting only one account at 

time. 

param = { 

  startDate : 'YYYYMMDD',   // Start date 

  endDate: 'YYYYMMDD'       // End date 

}; 

Introduced in 7.0.2.0 

  Table object  

This object represent a table. 

Properties  

name Return the xml name of the table. 

headers Return the xml names of all columns as an array. 

isValid Return true if the object is valid. 

rowCount Return tthe number of rows in the table. 

Methods  

addMessage(msg,rowNr,columnName) Add the message msg to the qeue of the 

document. If in the application the 

Option "Show Messages" is turned on, a 

dialog is show to the user. The message 

is in any case showed in the pane 

"Messages". If rowNr is different to "-1" 

the message is connected to the row 

rowNr. if columnName is not empty, the 

message is connected to the column 
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columnName. This enable with a double 

click over message in the message pane, 

to junp to the rowNr, columnName. 

Introduced in 7.0.2.0 

extractRows(function(rowObj,rowNr,table),tableHeader) Extract the rows that passed the test 

defined by function and show them in the 

table "Selections". The header of the 

table is set to tableHeader. 

Introduced in 7.0.2.0 

findRows(function(rowObj,rowNr,table)) Return an array of Row objects that pass 

the test defined in function. 

findRowByValue(columnName,value) Return the first row that contains the 

value value in the the column 

columnName. 

Introduced in 7.0.2.0 

row(rowNr) Return the Row at index rownr as Row 

Object, or an invalid Row Object if 

rowNr si outside the valid range. 

value(rowNr,columnName) Return the value in row rowNr and 

column columnName as string. If the 

row or column are not founds it return an 

object of type invalid. 

  Row object  

This object represent a row. 

Properties  

isValid Return true if the object is valid. 

rowNr Return the index of the row. 

Methods  

addMessage(msg,columnName) Add the message msg to the qeue of the document. If in the 

application the Option "Show Messages" is turned on, a dialog is 

show to the user. The message is in any case showed in the pane 

"Messages". If rowNr is different to "-1" the message is connected 

to the row rowNr. if columnName is not empty, the message is 

connected to the column columnName. This enable with a double 

click over message in the message pane, to junp to the rowNr, 

columnName. 

Introduced in 7.0.2.0 

value(columnName) 
Return the value in column columnName. If the column is not 

found or the object is invalid it return an object of type invalid. 
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  Tutorials  

Tutorial: create a new filter to import custom csv data 

  

Changelog API Version 7.0.2.0  

New objects, methods and properties 

Application.locale 

Application.version 

Application.progressBar 

ProgresBar.start(int) 

ProgressBar.step(int) 

ProgressBar.finish() 

Converter.tableToCsv(string, defaultChar) 

Document.locale 

Document.addMessage(msg) 

Row.addMessage(msg,columnName) 

Table.addMessage(msg,rowNr,columnName) 

Table.extractRows(function(rowObj,rowNr,table),tableHeader) 

Table.findRowByValue(columnName,value) 

Fixed methods 

Converter.csvToTable(string,separator,textdelim): The last line is imported correctly, even if it ends 

with the separator character. 

Converter.csvToTable(string,separator,textdelim): The last field is imported correctly, even if it 

ends with the text delimiter character. 

Converter.tableToTsv(string,defaultChar): Tabulators in strings are replaced with defaultChar or if 

defaultChar is not defined with a space. 

4.6.1.1.1.1 Tutorial: create a new filter to import custom csv data 

In this tutorial we want to create a new filter to import the following data: 
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Date;Description;Expense/Income;Amount 

29.05.2012;Book;E;13.00 

03.04.2012;Wage;I;3'500.00 

12.03.2012;Cinema;E;12.00 

02.03.2012;Pizza;E;1'090.00 

  

Let's write the filter: 

1. Open in Explorer the folder 

"C:\Users\{user_name}\AppData\Local\Banana.ch\Banana\7.0\Filters", or for Mac users 

open in Finder the folder "~/Library/Application Support/Banana.ch/Banana/7.0/Filters". 

  

2. Create a file named "ch.mycompany.filter.import.myformat.js" 

  

3. Insert the following text, take a deep look at the function covertTransaction(transaction). 

The function 'covertTransaction(transaction)' does the convertion from the custom format to 

the simple transaction format. 

// @id = ch.mycompany.filter.import.myformat 

// @version = 1.0 

// @pubdate = 2012-09-10 

// @publisher = My Company 

// @description = My Format (*.csv) 

// @task = import.transactions 

// @outputformat = transactions.simple 

// @inputdatasource = openfiledialog 

// @encoding = utf-8 

// @inputfilefilter = Text files (*.txt *.csv);;All files (*.*) 

 

/** 

 * Parse the data and return the data to be imported as a tab separated file. 

 */ 

function exec(string) { 

    var transactions = Banana.Converter.csvToTable(string, ';', ''); 

 

    // Remove the header line 

    transactions.shift(); 

 

    // Convert transactions to the simple accounting format 

    // From:  Date;Description;Expense/Income;Amount 

    //        29.05.2010;Book;E;13.00 

    // To:    Date;Description;Income/Expenses 

    //        20100529;Book;;13.00 

    // Do it in the fuction convertransaction 

    transactions = transactions.map( convertTransaction); 

     

    var header = [["Date","Description","Income","Expenses"]]; 

    return Banana.Converter.tableToTsv( header.concat(transactions)); 

} 
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/** Convert transaction to the simple accounting format */ 

function convertTransaction( transaction) { 

   var convTransaction = []; 

 

   var date = Banana.Converter.toInternalDateFormat( transaction[0]); 

   convTransaction.push( date);  // Date 

 

   convTransaction.push( transaction[1]);  // Description 

 

   var amount = Banana.Converter.toInternalAmountFormat( transaction[3]); 

   if ( transaction[2] === "I") { 

      convTransaction.push( amount);       // Income 

      convTransaction.push( "");           // Expense 

   } else { 

      convTransaction.push( "");           // Income 

      convTransaction.push( amount);       // Expense 

   } 

   return convTransaction; 

} 

  

4. Save the file 

  

5. In menu Account1 select 'Import to accounting...', click 'Manage filters...' and enable the 

filter 'My format', then click on 'Close'. 

  

6. Test it: in dialog 'Import to accounting' select the filter 'My format' and the file to import, 

then click on Ok. 

  

If we would like to sort the transactions by ascending dates we should add just few lines: 

1. Add a new function compareDates( transaction1, transaction2) 

 

function compareDates( transaction1, transaction2) { 

  if ( transaction1[0] < transaction2[0])  

     return -1; 

  if ( transaction1[0] > transaction2[0]) 

     return 1; 

  return 0; 

} 

  

2. Insert in the function exec(string) a call to the sort method 

 

function exec(string) { 

   ... 
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   transactions = transactions.map( convertTransaction); 

 

   // Sort transactions by date 

   transactions = transactions.sort( compareDates); 

   ... 

} 

  

For further examples take a look at the filters avaible at following address: 

http://www.banana.ch/portal/addons/filters. 

Or take a look in the folders "C:\Users\{user_name}\AppData\Local\Banana.ch\Banana\7.0\Filters", 

or for Mac users "~/Library/Application Support/Banana.ch/Banana/7.0/Filters" on your computer. 

  

For the complete documentation of the filter's api and syntax read the page Extending Banana 

Accounting 7 

  

4.6.1.3 Import Income & Expenses accounting transactions 

In order to import transactions from an Income & Expenses accounting file into a double-entry 

accounting file, it is necessary that the categories of the Income & Expenses file correspond to the 

accounts of the Double-entry accounting file. 

When importing choose the Import to accounting command from the Account1 menu and then 

select Income & Expenses accounting transactions (*ac2) from the appearing windows. 

http://www.banana.ch/portal/addons/filters
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Le spiegazioni di questa finestra sono disponibili nella lezione precedente Importa in contabilità  
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Le spiegazioni di questa finestra sono disponibili alla pagina Importa movimenti contabilità in 

partita doppia 

Select transactions  

Insert the start and end dates of the period related to the transfer of the transactions. 

Autocomplete values 

The option is only necessary with accounting with VAT/Sales tax and multi-currency. If activated, 

it allows the automatic completion of the values that are missing in the imported data (for example, 

the exchange rate in the exchange rate table or the VAT code for the transactions with VAT/Sales 

tax). 

Complete the transactions with  

These options automatically activate when data from bank or postal account statements or receipt 

and payment transactions of an account in test format are imported. 

Initial document number 

This is the document number assigned to the first imported transaction. 

Destination account 

Insert the bank account number of the chart of accounts related to the imported extract. 

  

4.6.1.2 Import data from a Cash book file 

When managing your accounting work, it is possible to manage the cashbook separately and 

regularly import the transactions in the main accounting file, grouped according to a selected 

period. 

In this case there are two separate files: a file containing all the data of the general accounting, and a 

second file containing only the data cashbook management.  

In order to be able to import data from the cashbook file into the main accounting file, those files 

need to be linked. This can take place in two different ways: 

 Attribute to the categories of the cashbook file the same account numbers (for double-entry 

accounting), or, the same category numbers (for income & expense accounting) as the ones 

used in the main accounting file. 

 In che cashbook file, in the Category2 column of the Categories table, enter the same 

account numbers as the main accounting file (if double-entry accounting) or the same 

categories numbers (if income & expense accounting). If the Category2 column isn't visible, 

you  need to visualize it by selecting the Columns setup command from the Data menu, 

and double clicking on Category2. 

Example: 

In this example, the account numbers referring to the main accounting file have been entered in the 

Category2 column.   
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In order to import the data, do as follows: 

 open the main accounting file and choose the Import to accounting command from the 

Account1 menu 

 click on Import transactions, select Cash book (*.ac2) and with the Browse button, select 

the cash book file. 
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You can find the explanations of this window at the Import to accounting page 
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In accounting 

Destination account 

This is the Double-entry or Simple Accounting account number to which the data will be carried 

over. 

Initial document number 

This is the document number given to the transactions carried over. 

Select transactions 

Start date / End date 

These drop-down menus specify the start and end dates of the period in which to import data. 

Group Transactions 

In this section the user specifies how the transactions of the period must be grouped: 

 No period grouping - all accounting period is shown 

 Montly - transactions are grouped by month 

 Quarterly - transactions are grouped by quarter 

 By semester - transactions are grouped by semester 

One transaction per account 

If more than one category is grouped on a single account but the user needs separate transactions for 

each category, this cell must be activated; then the program will create transactions for each 

category. When VAT codes are used, transactions will be created not only by category, but also for 

each different VAT code in the same category. 

Note:when the user is working on an accounting file with VAT, the calculations of the VAT may 

result slightly different. If the transaction amounts have been inserted as net amounts, the balance of 

the cash account may also be different because of rounding differences. 

  

The accounting file is updated with the data of the petty cash  
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4.6.1.4 Import Double-entry accounting transactions 

In order to import transactions from a Double-entry accounting file into another Double-entry 

accounting file, it is necessary that the accounts correspond. 

When importing the transactions choose the Import to accounting command from the Account1 

menu and then select Double-entry accounting transactions (*ac2) from the appearing window. 

 

You can find the explanations of this window at the Import to accounting page 
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Select transactions  

Insert the start and end dates of the period related to the transfer of the transactions. 

Autocomplete values 

The option is only necessary with accounting with VAT/Sales tax and multi-currency. If activated, 

it allows the automatic completion of the values that are missing in the imported data (for example, 

the exchange rate in the exchange rate table or the VAT code for the transactions with VAT/Sales 

tax). 

Complete the transactions with  

These options automatically activate when data from bank or postal account statements or receipt 

and payment transactions of an account in test format are imported. 

Initial document number 

This is the document number assigned to the first imported transaction. 

Destination account 

Insert the bank account number of the chart of accounts related to the imported extract. 
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4.6.1.5 Import transactions from statement 

The explanations for this window are the same as the ones for the Import Income & Expenses 

accounting transactions. The only difference is that the Complete transactions with section is 

active and allows the user to enter the initial document number and the destination account number. 

Once the import is done, the counterparty account will have to be entered manually. 

  

4.6.1.6 Import data from a txt file 

This allows the importation of the data of a file in text format. The condition to succeed in this 

operation is that the file columns to be imported should be given the same name used in the 

program for the Xml fields' headers. 

The explanations for this window are the same as the ones for the Import Double-entry 

accounting transactions. The only difference is that the Complete transactions with section is 

active and allows the user to enter the initial document number and the destination account number. 

Once the import is done, the counterparty account will have to be entered manually. 

  

Use the import in to account in Menu Account1  

The type of file to be used is a "Text file with column headers". 

 You can use any column name existing on the table 

 Fields header in the first line o the file Fields names a case sensitive and must correspond to 

the NameXml (English) 

 Fields and column name separator is to be tab separated "\t" 

 Each line (after a "\n") is a new record 

 The format for the Date fields is yyyy-mm-dd 

  

Example file (without tab stop)  

DateDoc Description AccountDebit AccountCredit Amount VatCode VatPercentNonDeductible 

2006-01-03 Bank to Cash 1000 1020 350.00 

2006-01-05 Office Supplies 6500 1000 32.50 E76 

  

Options  

 Import using clipboard data will use the content of the clipboard instead of the file 

 Autocomplete values Some fields of the transactions are automatically completed (see 

"Importing transactions for multicurrency double entry accounting"). 

 Unicode (utf-8) The content of the file is in Unicode utf-8 (it support any character set).  
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Importing transactions for multicurrency double entry accounting  

By importing multicurrency data there can be rounding or calculation differences due to different 

development tools used. To avoid such differences you should provide only certainfield and while 

importing the program will calculate the field values that are missing (with theoption 

"Autocomplete values") . 

 If you provide only "AmountCurrency" the program will use the default exchange rate and 

will calculate the "Amount". 

 In order to avoid error provide always the "ExchangeCurrency" 

 If you provide the "AmountCurrency"  and the "ExchangeRate" and the "Amount" are 0 o 

not present the program will calculate the exchange rate based on the column "Amount" and 

"AmountCurrency". 

  

Automated data importing  

The import of transaction can be automated using the command or DDE. 

For further information see "Command line and DDE" 

Note 

Be sure to use the last software version avaible on the web site.  

Version 4 allowed the user to import only certain columns. 

  

4.6.1.7 Import transactions from Text file with column headers  

This allows the importation of the data of a file in text format. The condition to succeed in this 

operation is that the file columns to be imported should be given the same name used in the 

program for the Xml fields' headers. 

The explanations for this window are the same as the ones for the Import Double-Entry 

accounting transactions. The only difference is that the Complete transactions with section is 

active and allows the user to enter the initial document number and the destination account number. 

Once the import is done, the counterparty account will have to be entered manually. 

  

More technical details about importing txt files can be found on the page Importing data from a txt 

file. 

  

http://www.banana.ch/cms/en/transferring_data_dde
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4.6.1.8 Import accounts 

By activating the Import accounts option from the Import to accounting command (Account1 

menu), the program will take the accounts or the categories in the current accounting file, allowing 

to select from the options indicated in the following window

 

Options 

Include Cost Centers 

Add new accounts 

When this option is activated, all new accounts are added to the accounting plan. 

Replace text description 

If already existing accounts are imported, but with different descriptions, the existing descriptions 

are replaced by the imported ones when this option is activated. 

Replace opening balance 

If already existing accounts are imported with different opening balances, the existing opening 

balances are replaced by the imported ones when this option is activated. 

  

4.6.1.9 Import VAT codes 

This fonction is only available in accounting files with VAT management, and allows the user to 

import VAT codes from: 

 another accounting file (*.ac2) 

 a text file with column headers (text file *.txt) 



91 

B A N A N A  A C C O U N T I N G  

 

Note: if, after the import, you receive the error messagge VAT account not found, you need to 

select the Automatic VAT account in the VAT/Sales tax section of the File and accounting 

properties (File menu). 

  

4.6.1.10 Import exchange rates 

This option is only present in Double-entry accounting with multi-currencies. 

The characteristics are the same as the ones of the Import transactions fonction. 

It lets the user import the exchange rates from: 

 Exchange rate table of another file or Exchange rate history file (*.ac2) 

 Text file with the column heading (text file *.txt). 

 

Note: Exchange rate history files only show the Foreign exchange rate table and keep a record of 

past exchange rates. 
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4.6.1.11 Transferring data from other accounting software 

With Banana, you can easily transfer data from any accounting program, passing through MS-

Excel. 

  

1. With the accounting program, export the data in a format that can be read by Excel (CSV, 

txt, ...) 

2. Open the file with Excel 

3. In Excel, organize the data (columns) as they appear in the Banana tables (Accounts, 

Transactions) 

4. Open your new accounting file in Banana 

5. In the Accounts or Transactions table, add as many empty rows as there are rows to transfer 

from Excel. 

6. In Excel, select the data to be copied and use the "Copy" command 

7. Go in Banana and execute the "Paste" command. 

This method is useful to transfer data from MS-Money, Intuit Quicken and Quickbooks, and from 

most other accounting programs. 

  

4.6.2 Merge file 

Il is possible to merge two files, but they have to belong to the same group (for example two 

double-entry accounting files). It is not possible to merge files belonging to different groups (for 

example one double-entry accounting file and one simple accounting file). 

In order to successfully merge two files, it is crucial that they have the same accounts numbering. 

Proceed as follows: 

 Open the file which will contain the data of both files 

 Select the Merge File command from the Tools menu 

 Select the path and the name of the file to be merged 

 Confirm the merge operation 

 If the files are not the same, even though they belong to the same group, (for example, 

accounting with VAT/Sales tax and accounting without VAT/Sales tax), a message will 

appear advising the probable loss of data. 
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4.6.3 Import rows 

 

The user can import data from other programs into the tables as long as they can be transformed 

into one of the formats listed in the Format area. 

File name 

Using the Browse button, select the file from which to extract the data. By clicking on the OK 

button, confirm the options selected. 

Format 

This area contains the list of formats with which it is possible to import the data to the table. These 

include: ASCII format, Text, CSV. 

Options  

Import data from clipboard 

By selecting this box, the user can import data from the Windows clipboard. 

Autocomplete values 

It is advisable to select this function when it is necessary to import rows from a less complex 

accounting file into a more complex one. In this case, in the imported rows, some columns will stay 

blank. By selecting this function, the program will automatically complete the missing values with 

those from the current accounting. 

Fields header   

By selecting this box, not only data, but field headers will be included in the import. 

Unicode (Utf-8) 

By selecting this box, all the data will be imported in a format readable by Unicode programs. 

  

4.7 Help Menu 

The Help menu gives access to the followings commands: 
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 Reference's guide - access to the explanation of all program functions's windows 

 User's guide - access to all documentations and explanation of all technical and accounting 

topics 

 Keyboard shortcuts - list of all keyboard shortcuts with detailed use description 

 Support center - access to Banana support web page 

 Register - access to Banana web page for users registration 

 License key - allows to enter the license key for the program 

 About Banana Accounting - access to technical information about the program such as 

version number, serial number, Copyright..... 

  

4.8 Program options 

In the Program options window, several technical options are possible for the accounting file. 

Interface Tab  

 

Program  

Language 
The Program Language is the language used by the program. Use this drop-down menu to select a 

language if the user wants to use a language different from the default or if the default is not 

available. 
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Font type 

This drop-down menu allows the user to select the desired font. If the selected printer doesn't print 

all the fonts, change the font with this menu. 

%Zoom 

If the user wants the data on the table to be shown in another size, adjust the percentage of Zoom 

here. 

Show negatif numbers in red 

The negatif numbers and amounts will be shown in red in the tables. 

Startup  

Check for updates 
This option establishes a connection to the Banana.ch SA website and checks if there is an update 

compared to the version that is used. 

Display start page 

The news start page is shown. 

Show recently used files 

In the File menu, all the most recently used files are listed. 

  

Editor Tab  
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Behavior  

Edit table with single click 
By activating this option, a single click on the selected cell is sufficient to enter in the modification 

mode. If the function is not activated, you have to double-click on the cell in order to enter in the 

modification mode. 

Autocomplete text 

By activating this option, the program automatically selects the first draft text in the drop down list 

and automatically fills it in the line where you are. 

Add up during selection 

By activating this option, the program will add up the selected amounts. Deactivate this function if 

this instantaneous addition slows certain operations down. 

Input  

Maximum number of undo operations 

Insert the maximum number of undo operations (one at a time) when using the Undo command 

from the Edit menu. 

Smart fill rows limit 

When inserting data, the program reads the data that has already been entered and tries to suggest 

how to complete an entry. In cases where there are many rows, this function could slow down the 

process. 

The user can define a limit for the number of rows, above which the smart fill will not be used. If 

there is no value entered or zero, smart fill will always be used. 

Autocomplete Text 

If this function is activated, the program will automatically select the first text proposal of the drop 

down list and enter it in the selected row. 

  

Advanced Tab  
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Backup  

Autosave (in minutes) 

This option allows saving the file automatically according to the desired frequency (in minutes). 

The program saves the data in a file called auto backup + file name. If the program or the computer 

crashes, the data can be recuperated by opening this file and saving it with a name (Save as...) from 

the File menu. 

Create backup copy (.bak) 

When the user saves to disk using the same name, the version of the file that already existed is 

renamed with a .BAK extension. 

Files extension  

Extensions of files considered secure 

This option defines the file types that the software consents to open with a double click on the 

DocLink column of the Transactions table. This prevents from opening non-secure files by the 

program. 

  

Restore Defaults 

If some settings have been altered, by using this button, the default settings will be restaured. 
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4.9 Printouts/preview 

For more information on specific printouts for the different accounting types pleas visit the 

following links: 

 Double-entry accounting 

 Multi-currency accounting 

 Cashbook and Income & Expense accounting 

 VAT Report 

 Swiss VAT form - page in Italian, German or French 

  

4.9.1 Preview  

All the printouts of the various accounting documents can be saved in PDF, HTML, MS Excel and 

copied to the Clipboard, allowing the user to also access them many years later. 
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4.9.2 Print 

 

The button pulls up the Printer Setup window from Windows. The selections are only valid for the 

current working session. Permanent alterations need to be input using the Windows control panel. 

Horizontal or vertical printing needs to be input under Page Setup and is only valid for each view. 

  

5 Double-entry accounting 

The professional tool to manage assets, liabilities, expenses and income according to the 

international rules of the Double-entry (debit and credit) and to obtain a Balance Sheet and a 

Profit/loss Statement. 

The double-entry accounting application is available with or without the VAT management option. 

   

  

Characteristics 

 Manages the estate accounts and the profit/loss accounts (assets, liabilties, expenses and 

revenue) 

 The accounting type with VAT features the VAT calculations and VAT reports 

 Produces all the accounting extraits: journal, account cards, balances by period and annual 

balances  

 Allows to manage Cost Centers and Segments 

 Offers different ways of data presentation 
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 Exports data to Excel, Html, Xml, Pdf 

 Imports data from different files formats 

  

Tables and File properties 

The double-entry accounting is composed by the follwing tables: 

 Accounts table 

Where the accounting plan is located with opening balances, and where groups and 

subgroups can be defined along with cost centers and segments. 

 Transactions table 

Where the accounting transactions are entered. 

 VAT Codes table 

Where the VAT/Sales tax codes are set, only the VAT management option has been chosen. 

 Exchange rates table 

Where the different currencies are defined - only in the multi-currency accounting 

 File properties 

Where the accounting general settings are defined. 

  

5.1 How to start 

In order to create a new a new accounting file, choose the New command from the File menu 
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Group 

In the Group section all the different applications are listed. Choose the one that meets your needs. 

File 

In this section you can select the characteristics of the choosen application. You can choose 

between the plain version, with the VAT management, with a second currency or with more than 

one currency. 

Examples/Templates 

By selecting the language you will see predefined example/models that you can use to start and that 

can be personalized. All the template data and settings (language, decimal rounding, ..) will be used. 

Once you have personalized the template you need to save the file with a new name. 

  

In order to star a new accounting file there are two possibilities: 

1. Start from a pre-defined example and adapt it to your own needs - suggested method 

2. Create a new empty file with an accounting plan to be created from scratch 

First method: 

 Select the Double-entry accounting Group, then, in the File section choose Double-entry 

or Double-entry with VAT/Sales tax 

 In the Examples/Templates section select the language/country and choose one of the 

examples that most meets your requirements 

 Enter the File and accounting properties 

 

You can find more detailed information about this window at the File and accounting properties 

page 
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 Save the file under a new name (Save as...) 

 In the Accounts Table, make all the necessary changes to personalize your charts of 

accounts: you can add or delete lines, change the accounts numbers and descriptions, create 

more groups, etc. 

 

For example, in the following image the 1020 account description has been changed. 
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In case an account is missing, just move to the Accounts table, add a new row and complete it with 

the account number, the description, the Bclass and the Group in order to create a new account. 

For more information on how to create a Chart of Accounts, please consult the section Groupings in 

the Chart of Accounts 

Second method: 

 Select the Double-entry accounting Group, then, in the File section choose Double-entry 

or Double-entry with VAT/Sales tax 

 In the Examples/Templates section select the language/country and choose the New 

blank file option 

http://www.banana.ch/cms/en/chart_of_accounts_setup
http://www.banana.ch/cms/en/chart_of_accounts_setup
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 Set up the Outline to create new file 

 

 Setup the File and accounting properties 

 Create the accounting plan structure 

  

5.1.1 Opening balances 

When using Banana Accounting for the first time, the opening balances need to be inserted 

manually in order to create the opening balance sheet. 

After having set up the Chart of Accounts, proceed as follows: 
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1. Place yourself in the Accounts table, Base view, Opening column. 

2. Enter the opening balances of the Assets and Liabilities accounts manually. The Liabilities 

are entered preceded by the minus (-) sign. 

3. Check if the total Assets equals the total Liabilities so that your accounting balances. 

 

  

In order to automatically transfer the opening balances for the next year, consult the lesson Create 

New Year 
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5.2 Chart of accounts 

In the chart of accounts (Accounts table) the follwing data are entered: 

 The accounts 

They indicate on what account (debit ore credit) the trasactions must be registered. 

Each account has a code or number (account number), a description, a class and a group to 

which it belongs; they also have an opening balance, the current balance, the budget, etc... 

 Costs and Profits centers 

They are special accounts whose number is preceded by a full stop ".", a comma "," or by a 

semi-colon ";". Their purpose is to be able to assign some amounts to special accounts other 

than the basic accounting accounts. 

 Segments 

They are a sort of sub-accounts whos number is preceeded by a ":". Their purpose is to be 

able to assign some transactions to subcategories of the accounting plan. 

 Groups 

Their purpose is to create rows where the program adds up the amounts of other rows. 

 Sections 

They indicate the accounting plan divisions for the Balance Sheet and Profit and Loss 

Statement printouts, ... 

  

Columns 

The accounts table has several predefined columns - some of them can be edited (for example the 

Opening balance column). Some columns are protected and cannot be edited since they are 

calculated by the program (for example the Balance column). 

The columns layout can be changed. With the same command it is also possible to create new ones. 

If a new columns with amounts is created, the program will automatically calculate the totals just as 

for the Balance and Opening Balance columns. 

  

Views 

The accounting plan has its own predefined views. 

The current views can be edited and new ones can be created with the Setup views command. 

  

5.2.1 Accounts 

Bookkepings accounts 

In order to create an account you need to be in the Accounts table and enter a number or a code in 

the Account column. 

This same number is then used in the Transactions table as Debit or Credit account. 

 The account number can be composed by numbers, letter and separations characters. 

 It is not possible to have more than one account with the same number. 
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 Each account must have a BClass and must belong to a group. 

  

Classes 

Each account must belong to one of the following BClasses: 

 1  for Assets 

 2  for Liabilities 

 3  for Expenses 

 4  for Income 

The BClasse number must be as indicated, regardless the account or group code. 

It is also possible to create Off Balance Sheet accounts (for example for cauzioni, e impegni 

condizionali), that must have the following BClass: 

 5 for Off Balance Sheet: Assets 

 6 for Off Balance Sheet: Liabilities 

  

Opening balances 

The opening balance of each account is entered in the Opening balance column. 

 The Assets balances are shown normally 

 The Liabilities balances are entered with the minus sign (negative) 

 Usually only the Assets and Liabilites opening balances are entered. 

In order to automatically transfer the opening balances for the following year, please visit the Create 

New Year lesson. 
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Opening balances difference 

In a correct accounting file, the total of the Assets balance should be equal to the Liabilities opening 

balances, so no differences are shown. 

If the totals do not match, the program will show a warning message telling you that there is a 

opening balances difference. 

If you have changed some account numbers and you think the error message is not correct, please 

Recheck the accounting. 

When using Banana Accounting for the first time, the opening balances must be entered manually. 

  

5.2.2 Accounts with addresses 

In order to manage addresses, it is possible to add some specific columns in the accounting plan: 
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choose the Add new fonctionalities command from the Tools menu. 

 

This command will add, in the Accounts table: 

 several columns (first name, last name, company, ...) that allow you to enter the addresses 

data 

 the Address view where all the new columns are shown (to edit the view or the columns 

display, visit the Columns and views page). 

  

Clients and suppliers register 

When you have a Clients/Suppliers register in the Chart of Accounts (specific accounts for each 

client/supplier), and when it is needed to have complete data with the address, telephone number, 

email address, VAT/Sales tax number, etc., you can set up and visualize these data by activating the 

Address view. 



110 

B A N A N A  A C C O U N T I N G  

 

5.2.3 Groups 

In order to set up a chart of accounts, create the principal groups; for every group a Gr, to which the 

group belongs, has to be indicated: 

 D1 groups the accounts of the Balance sheet 

 2301 indicates the profit or loss of the current year 

 D2 groups the accounts of the Profit & Loss statement 

 

 Add new, blank rows 

 Complete the process by inserting the account numbers, the description, the BClass and the 

Gr to which the accounts belong. The BClass is mandatory and should be as follows: 1 for 

Assets, 2 for Liabilities, 3 for Expenses, 4 for Income. 
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 In the first Section column, once you enter the balance sheet and profit and loss statement 

headings, you need to enter the following numbers: 

 

The accounts from 1000 to 1360 have Gr 1, equal to Group 1 which adds up the Total assets 

The accounts from 2000 to 2300 have Gr 2, equal to Group 2 which adds up the Total liabilities 

The Total assets and Total liabilities have D1 as Gr, equal to Group D1 where they are added up, 

obtaining the balance of the Balance sheet. 

The procedure for the Profit & Loss statement continues in the same way: 
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The accounts from 3000 to 3340 have Gr 3, equal to Group 3 which adds up the Total expenses 

The accounts from 4000 to 4200 have Gr 4, equal to Group 4 which adds up the Total income 

The Total expenses and the Total income have D2 as Gr, equal to Group D2 where they are added 

up (Profit/Loss from Profit & Loss Statement). 

The Profit/Loss from the Profit & Loss Statement has 2301 as Gr, and is added up in the 2301 

group in the liabilities. 

  

In order to complete the Chart of accounts, the Section column also needs to be setup. 

  

Related documents: 

 Sections 

Subgroups 

Opening balances 
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5.2.3.1 Subgroups 

Insert subgroups  

In the Chart of Accounts, the subgroups give the possibility to obtain totals on more than one level 

and obtain more detailed information in the presentation of the Balance sheet. 

  

Example: 

The user wants to create a new Liquid assets subgroup that groups the cash, bank, and post office 

accounts. 

 

To create the Liquid assets subgroup you need to: 

 insert an empty row 

 in the Group column, enter the 100 code 

 in the Description column, enter Total Liquid assets 

 in the Gr column, enter 1 

 in the Gr column of the 1000, 1010 and 1020 accounts, enter 100 instead of 1. 
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Delete subgroups  

If the Chart of accounts has some sub-groups that are no longer needed, it is possible to delete them. 

  

Example: 

The user wants to delete the Total loans subgroup. 

 

To delete the Total loans subgroup you need to: 

 delete row 20 

 change the Gr for the 2100 and 2400 accounts from 200 to 2. 



115 

B A N A N A  A C C O U N T I N G  

 

5.2.4 Sections 

In order to create automatically a Balance Sheet by groups, the chart of accounts needs to be 

configured with special codes that are to be entered in the Section column. 

The encoding is the following: 

For more details please visit the Sections logic page 

* Title 1 To enter for the main headers 

** Title 2 To enter for the secondary headers 

1 Assets To enter in the title row Assets 

2 Liabilities To enter in the title row Liabilities 

3 Expenses To enter in the title row Expenses 

4 Revenue To enter in the title row Revenue 

01 
Client's 

Register 
To enter in the title row Client's Register 

02 
Supplier's 

Register 
To enter in the title row Supplier's Register 

03 Cost Centers To enter in the title row Cost Centers 

04 Profit Centers To enter in the title row Profit Centers 

<p"#3638_*< 

p=""> 

</p"#3638_*<> 

Notes To enter in the title row Notes 

<p"#3638_x< 

p=""> 

</p"#3638_x<> 

Hidden data 
To enter in the row from whereon the data have 

to be hidden 
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 Enter a * on the same row as the title Balance Sheet 

 Enter 1 on the same row as the title Assets 

 Enter 2 on the same row as the title Liabilities 

 

 Enter a * on the same row as the title Profit/Loss Statement 

 Enter 3 on the same row as the title Expenses 

 Enter 4 on the same row as the title Revenue (Income). 

Attention: in case a chart of accounts with Expenses and Revenue mixed (with the calculation of 

the Gross Profit) is being used, insert a  "*" on the title row "Profit/Loss Statement" and only the 

number 4 on the row preceding the row containing the title "Expenses" or "Revenue". 
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For the clients/suppliers register a new section is being defined, by entering an asterisk as usual. 

 Enter 01 on the same row as the title Clients register 

 Enter 02 on the same row as the title Suppliers register 

The amounts will be shown in the same way as for the Assets and the Liabilities. 

This encoding is also valid when the clients and suppliers are configured as cost centers. 

Example in case there is a clients/suppliers register in the chart of accounts. 
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In case there are cost or profit centers configured, enter the following elements 

 An asterisk for the section change 

 03 on the same row as the title Cost center 

 03 on the same row as the title Profit center 

The amounts will be shown as positive (in black) like the expenses and in red like the revenue. 
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5.2.4.1 The Sections logic 

The Sections different encoding determines how the printout will come out. 

Each section is printed as a separate table. 

The directories  

 * Title 1 creates a level 1 directory. 

It can contain level 2 sections or directories. 

It is useful to group sections that need to be printed together, such as the Balance sheet, 

which contains Assets and Liabilities. 

 ** Title 2 creates a level 2 directory. 

The Base sections  

The Section number or code determines 

 how the amounts are printed. 

The amounts can be visualized just like in the Balance sheet or inverted. 

If the Credit amounts (in negative) are inverted, they will be visualized in positive, and the 

positive amounts will be visualized in negative. 
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 which amount columns will be used 

The Balance column or the Period Movement column are used. 

The Balance column indicates the account balance at a specific date (balance at Jun 30th). 

The Total Period Movement column indicates the movement amount on the indicated 

period. 

It is used for the Profit and Loss Statement and indicates the costs or the revenues for a 

certain period. 

Here is the explanation of the different sections 

 1 Assets (amounts as in the accounting plan, balance column) 

 2 Liabilities (inverted amounts, balance column) 

 3 Costs (amounts as in the accounting plan, total movement column) 

 4 Revenues (inverted amounts, total movement column) 

This section can be also used alone and it can include both costs and revenues (Conto 

economico a scalare). In this case revenues would be displayed in positive and costs in 

negative. 

These sections must be unique. Therefore there can only be one 1 Assets, or one 2 Liabilities 

section. For other sections, like clients/suppliers register or cost center similar sections can be used. 

Derivatives Sections  

Those are Sections that are similar to the Base Sections 

 01 Similar to Assets (amounts as in the accounting plan, balance column) 

It is used for the clients register. 

 02 Similar to Liabilities (inverted amounts, balance column) 

It is used for the suppliers register. 

 03 Similar to Costs (amounts as in the accounting plan, total movement column) 

It is used for Cost Centers. 

 04 Similar to Revenues (inverted amounts, total movement column) 

It is used for Profit Centers. 

Other Sections  

There are other kinds of sections 

 

It is used for the Balance sheet attachments  

 #X Hidden Section. This section is not included in the sections selection and it is not 

printed. 

It is used to indicate parts not to be printed. 

  

Columns width in printout  

The columns width is automatically set by the program. 
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Sections 1, 2, 01, 02 have the same width as the columns. 

Sections 3, 4, 03, 04 have the same width as the columns. 

5.2.5 Segments 

Introduction  

Thanks to the segments, additional entities to which the amounts of the recordings are attributed to, 

may be created. 

When you register, you enter in addition to the account to be debited or credited the code for the 

segment, for example (1000-10-100-200). 

The segments are used for accounting reports broken down by Department, Project, Branch. 

Configuration of the segments  

The segments have to be configured in the Accounts table, at the end of the chart of accounts, 

indicating in the column account 

 Segment are accounts preceded by a colon ":". 

 There may be up to 10 levels of segments. 

 The number of colons preceding the symbol for the segment indicates the number of level.  

o :10 segment of level 1 

o ::10 segment of level 2 

o :::10 segment of level 3 

 The different levels of the segment are independent of each other. 

 The segments do not have classes and do not have currency. 

 The calculations for segments are done in basic currency. 

For the configuration, proceed as follows: 

 Insert the title "Segments" in the Description column to define the section relative to the 

segments 

 Insert an asterisk in the Section column 

 Insert the description of the first-level segments, and in the Account column, insert ":" 

 List the segments of the first level, entering an identification code for each one of them in 

the Account column, preceded by ":" 

 Proceed by entering the segments of the second level (and, if necessary, those of the third), 

in the same way as those of the first level, with the only difference that the segment codes 

need to be preceded by "::" or by ":::", depending on their level 
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Transactions  

The segments are being entered in the Transactions table, followed by the main account from the 

account segment.  

Each segment is preceded by the colon, or by the minus sign (-), in case the option Use the minus 

sign (-) as segments separator has been activated in the File and Accounting properties (File 

menu). 

The use of the colon “:” in the segments is advised when there are account codes with a minus sign 

in the Chart of Accounts.  

When a segment that belongs to more than one level, the segment of the first level needs to be 

entered right after the main account; then, continue with the code of the second level. 
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Report  

Reports of the segments are obtained with the commands Enhanced balance sheet with groups or 

Accounting report. 

These commands have a section Subdivision within which it is possible to indicate to create the 

columns for the segments, selecting the segments to be obtained. 

  

  

Segments for the project 
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Segments per branch 
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Documento correlato: Managing different projects 

  

5.2.6 Cost and Profit Centers 

The cost and profit centers are groupings that allow you to have details outside of the accounting for 

reporting purposes, within the firm. 
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The cost centers and profit are the groupings that allow you to have the details outside of 

accounting  

Particulary for managing: 

 Projects 

 Events 

 Building sites 

 Clients and suppliers 

 Members 

 Extra details for certain expenses 

Characteristics  

 Each cost and profit center has its own account card, complete with movements and balance 

 Un illimited number of cost centers can be created  

 Up to three types of cost centers can be managed, and each cost center may have different 

subgroups. 

Maximum three types of cost centers  

Maximum three types of cost centers can be indicated; they need to be set up with the following 

punctuation preceding the account number:  full stop, comma and semicolon. 

 

Cost center CC1 (with a full stop) can, for example, be used to enter all the transactions pertaining 

to a certain project, CC2 (comma) for a department, and CC3 (semicolon) to keep track of the 

transactions of a client or supplier. 

 

    CC1 column in the Transactions table,  account number preceded by a full stop 

    CC2 column in the Transactions table,  account number preceded by a comma 

    CC3 column in the Transactions table,  account number preceded by a semicolon 

  

Configuration of cost centers  

The three types of cost centers must be entered before the account with the following punctuation: 

full stop ".", comma "," and semicolon ";". 

To set up the cost centers proceed as follows: 

 In the column Section, inserirt a * for the change of section and in the following row insert 

03 (or 04 for a profit center). These settings will be required for the presentation of cost 

centers in the Enhanced balance sheet with groups 

 Insert blank rows for the number of cost centers to be included 

 In the column Group column, enter the group of origin 

 In the column, enter the accounts cost centers in the column account, preceded by a full stop 

"." for those to be registered in column CC1 (table Transactions), a comma ",", for those to 

be registered in column CC2 and the semicolon ";" for the ones to be registered in the 

column CC3. 
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Properties (VAT amount)  

In File properties (dati base), section VAT you can set the amount of cost centers with the 

following options: 

 Use transaction amount - The amount of the cost center is registered according the 

registration amount 

 Use amount exclusice VAT - The amount of the cost center is registered net of VAT. 

 Use amount including VAT - The amount of the cost center is registered gross of VAT. 

  Registrations  

In order to register on cost centers, it is assumed, that cost centers have already been entered in the 

accounts plan. 

To proceed with the registrations, register the table Transactions, view Cost centers, columns CC1, 

CC2, CC3, the account of the cost center without punctation which precedes. 
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Account card of cost center  

The cost center is treated as any other account, so each cost center has its own account card 

with account balance and account transactions. 

In order to view all cost center account cards, click on the command Account/Category cards in 

the menu Account1, Simple1, and then on the button Cost centers. 

  

Negative entry  

For Simple Accounting and Cash Book, the cost center entry follows the transaction amount. A 

negative entry is made in the case of expenses. 

In double-entry accounting (and optionally for Simple Accounting and Cash Book) the cost center 

code is entered, preceded by a minus sign (credit) (-CC1, -CC2, -CC3). 

  

Different groups in one cost center  

In order to manage different groups, belonging to the same type, in one cost center, you must enter 

the different groupings (with comma, full stop or semicolon) in the selected cost. The following 

example the groupings have been entered in the cost center CC3 (with semicolon): 
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In order to allocate the cost center to a specific group in the table Transactions, you must enter the 

account specific cost center. In our example, being a cost center set with a semicolon, the cost 

center must be entered in Column CC3, view cost centers. 

 

In the balance of the cost centers amounts, totals and grand totals for the group are automatically 

reported. 

  

Related documents: 
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 Managing partners of an association 

 Customers and suppliers with VAT on paid invoices 

  

5.2.7 Add / Rename 

Adding a new account 

 Position yourself in the row above the one where you want to add the new account 

 Add a new empty row with the command Add rows from the Edit menu 

 In the columns, insert the account number, the description, the BClass (1 for the Assets, 2 

for the Liabilities, 3 for the Expenses and 4 for the Revenue), and the Gr which needs to be 

the same as the one inserted for the accounts belonging to the same Group. 

Note: If you first enter a transaction with a non existing account and later you create the new 

account in the accounting plan, you will first get an error message, that will go away only if you 

recheck the acccounting with the Shift + F9 key, or the Recheck accounting command from the 

Account1 menu. 

  

Adding a new group 

 Position yourself in the row above the one where you want to add the new group 

 Add a new empty row with the command Add rows from the Edit menu 

 In the columns, insert the group number, the description and the Gr which needs to be the 

same as the group you wish this group to be totalized. 

  

Renaming an account or a group 

 Position yourself in the Account or Group column in the Acounts table (or in the VAT code 

column in the VAT codes table) 

 Choose the Rename command from the Data menu 

 Enter the new account, group or code number 

The program will automatically update the Transactions table with the new number or code. 

  

Deleting an account or a group 

 Position yourself on the row number that contains the account that is to be deleted 

 From the Edit menu, click on the Delete rows command 

 Enter the number of rows that you wish to delete 

After deleting an account or a group it is necessary to use the Recheck accounting command. The 

program will give you a warning message if the deleted account or group was used in the 

Transaction table. 



131 

B A N A N A  A C C O U N T I N G  

  

5.3 Transactions 

Transactions must be entered in the Trasactions table. 

Speed up the input process 

In order to speed up entering transactions, we suggest to activate the Smart Fill with transactions 

from previous year option (from the File menu choose the File and accounting properties 

command, Options tab), and, if you have recurring transactions, we suggest to create the 

Recurring transactions table, so when needed you can automatically enter them (from the Cash2, 

Simple2 or Account2 menu choose the Recurring transactions command). 

  

Smart Fill 

When the beginning of a text is inserted, the program shows a drop down dialog with all of the texts 

inserted before, by means of the Smart fill feature. Select the desired text to be inserted and press 

the F6 key. The program automatically inserts all the earlier inserted data of the similar line. 

Eventually change the amount if it is not identical to the old amount. For more information please 

visit the Text imput, edit and Smart fill page. 

  

Recurring transactions 

Simply copy and paste the recurring transactions from the Transactions table into the Recurring 

transactions table (you can open this table by choosing the Recurring transactions command 

from the Cash2, Simple2, Account2 menu; in the Doc column insert initials or an identification 

code. 

When you need to recall the recurring transactions, from the Transactions table, type the initials or 

identification code for the memorized text in the Doc column and press the F6 key. The program 

automatically inserts all the transactions of the memorized rows. 

  

Simple transactions 

Simple transactions are the ones regarding two accounts (one Debit account and one Credit account) 

and entered in one single row. Each transaction has its own document number. 



132 

B A N A N A  A C C O U N T I N G  

Example: withdrawal of 350.- USD from the post office account. 

 

Composed transations 

Composed transactions have to be entered on several rows. The user should enter one account per 

row and there can be several counter parties in debit and/or credit. 

In this case the same document number is used on all the transaction rows. 

Example: payment of two different bills (electricity and telephone) from the bank account 

 

  

5.3.1 Displaying expiry dates 

To display the expiry dates of the payable invoices and those receivable, the issued and received 

invoices need to be registered. 
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The columns Date Exp. and Date Pay. have to manually be displayed by choosing the Columns 

setup command from the Data menu.  

 

For each invoice enter the expiry date in the Date Expiry column; then, when the invoice is paid, 

enter the payment date in the Date Payment column.  

 

In order to view all unpaid or receivable invoices, activate the command Show expiry dates from 

the Account2 menu. 

All the invoices that do not have a payment date will then be shown in a separate table (Selections 

table).  
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5.3.2 Link to a document 

In order to be able to insert a link to a document, the DocLink column should be displayed on the 

Transactions table (see the Columns display page). 

 

 Place yourself in the DocLink column and the activate the Add link command from the 

Account2 menu 

 Select the file that corresponds to the document which needs to be connected and click on 

the Open button; the program inserts the link automatically.   

An internet address can also be entered manually in the Link column. 

In order to open the connected document choose the Open link command from the Account2 

menu. 

  

5.3.3 Lock transactions 

With the Lock transactions command, the accounting transactions are blocked and marked with 

control codes that can certify, over the years, that the transactions have not been modified. This 

method (US Patent No. 7,020,640), based on electronic signature, guarantees one of the highest 

levels of data integrity since it can demonstrate with no doubt that the accounting has not been 

altered, as international laws prescribe. 

http://www.banana.ch/cms/en/legal_en
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Date of new lock (inclusive) 

Specify the date up until when the transactions will be locked. 

Password (optional) 

It is possible to insert a password to eventually unlock the transactions or to carry out a new lock in 

the future. 

If the program finds no errors in the transactions included in the lock date, it will lock the 

transactions, calculate and assign individual numbers and codes to each row of transactions which 

can be viewed in the Lock view on the Transactions table. 

Last lock 

The data of the following fields are automatically filled by the program based on the last executed 

lock. 

Lock valid 

A "Yes" is shown if the lock is valid. 

Date of lock 

The date of the last executed lock is shown. 

Lock number 

It's the value automatically entered by the program in the last row of the LockNum column. 

When the lock is repeated, if the value of the last row lock number is unchanged, it means that the 

lock is valid and that data has not been altered; if however the value is changed, the program shows 

the following codes: 

 (-1) if the lock is unvalid from the first row 

 (-2) if there are rows that have the same LockNum. 

Progressive Hash 

This is the control code present in the last transaction. 
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By confirming with the OK button, the lock information window will automatically show. 

All data in this window are automatically inserted by the program. 

The program will recalculate the controls codes (hashes) and will verify if they correspond to the 

ones related to the transactions. If the codes correspond the lock is valid, if not, it means that 

changes have been made and the lock is not valid. 

 

Info file 

All information related to the file creation are shown. 

LockTransactions 

All information related to the transaction lock are shown (use, valid) 

All transactions until the indicated data are locked and checked by a series of counters. 
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 LockNum: the progressive number that identifies the row 

 LockAmt: the cumulative transactions total, similar to the total at the end of the page, as 

required by some national regulations 

 LockProg: electronic signature (Hash MD5) that is the unique identification of all the 

transactions up to the point of entry. 

  

Control code (Hash Md5) 

This is the main element of the certification, which takes the following into account: 

 The contents of the current entry 

 The contents of all the preceding transactions 

 The progressive number (LockNum) 

 The cumulative balance (LockAmt) 

The control number is different if the accounting data undergo even the slightest modification (a 

date or an amount is changed). If the control number remains the same, this means that the data are 

original and therefore have not been changed. 

The program automatically inserts the values in this section.  

  

Recording the certification number 

Once the transactions in the period have been locked, it is enough to print the last certified row with 

the relevant certification number (LockProg) and to store this information in a safe place. If the 

certification number remains unchanged over time, it means that the data have not been modified. 

Before launching a new lock, verify the data of the previous lock by recalling the Lock 

transactions command from the Account2 menu. 

 



138 

B A N A N A  A C C O U N T I N G  

Unlock transactions 

The Unlock transactions command removes the lock and the control hashes. If the lock was set 

with a password it will be necessary to type the password in order to remove the lock. 

If later on you want to relock the transactions, if they have not been modified, the lock hashes will 

be the same; if however some data has been changed, the control hashes will be different. 

  

Related documents 

Some time ago, Banana.ch requested the auditing firm Ernst&Young to analyze this certification 

method and the firm approved and certified it as being in compliance with Swiss and German laws. 

 Document related to Swiss certification (PDF in German) 

 Document related to German certification (PDF in German) 

 

Long-term archiving 

The accounting data are always accessible even after long periods of time. 

Banana Accounting allows all the accounting data to be exported to Html e Xml. The generated file 

may be saved on a CD and accessed on any computer even after many years, even by persons who 

do not have the Banana Accounting software. 

 

Related document: Archiving in Html and XML 

  

5.4 File and accounting properties 

This is where the main data of the accounting file are entered, such as the printout heading, the 

opening and closing dates, the basic currency, the company address, the profit and loss from 

exchange rate variation account (if you have a multicurrency accounting file), the VAT account (if 

you have chosen the VAT management option), the password, … 

The File and accounting properties window has the following tabs: 

 Accounting tab 

 Options tab 

 Address tab 

 VAT/ICMS tab 

 Foreign currency tab 

 Texts tab 

 Password tab 

 Other tab 

  

http://www.ey.com/
http://www.banana.ch/accounting/files/ernstyoung_beurteilung_banana_ch.pdf
http://www.banana.ch/accounting/files/ernstyoung_beurteilung_banana_de.pdf
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5.4.1 Accounting Tab 

 

Left and right headers 

These are the two empty cells at the top where any desired text can be inserted which will be used 

as a header for print-outs (left and right). 

Opening date 

The opening date is the date when the accounting begins. It can also be left blank. If a date prior to 

the opening date is inserted when entries are made, the program will give an error message. 

Closing date 

This is the closing date of the accounting. It can also be left blank. If a date greater than the closing 

date is inserted when entries are made, the program will give an error message. 

Basic currency 

The code of the currency in which the accounting is being handled. When the code of the basic 

currency is being changed, the program changes the column headers for the amounts in basic 

currency using the new code. 
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5.4.2 Options Tab 

 

Transaction date required 

If this option is activated and then a transaction is entered without a date, there will be an error 

message. 

Recalculate totals manually (F9) 

If this option is activated, the program will not automatically recalculate the principal groups of the 

accounting file, but the user needs to use the F9 key. 

File from previous year 

By using the Browse button, the user can select a file from the previous year. If the Smart fill with 

transactions from previous year cell is activated, the program keeps the transactions from the 

previous year in memory, and offers them as Smart Fill while the user inputs new entries. 

Use the minus sign (-) as segments seperator 

When this option is activated, the segments have to be entered in the Transactions table with the 

minus (-) sign preceding the segment code. When this option is deactivated, the segments need to be 

entered with the colon sign (:), as in the chart of accounts. The colon needs to always preceed the 

segment code. 

Records (+/-) cost centers according to the category 

This function is active only for Simple accounting and Cash book. By activating this box, the 

amount is entered in the cost center (positive or negative) according to the category. 

If, instead, this option is not active, in order to enter a negative value, it is necessary to enter a 

minus sign before the cost center (-CC). 
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Related document: Text imput, edit and Smart fill 

  

5.4.3 Address Tab 

In this tab data about the company or the individual whose accounting is being handled can be 

entered. 

 

  

5.5 Recheck the accounting 

Recheck the accounting 

This is one of the most useful features: all the accounting file is rechecked, all the balances are 

recalculated and the user is notified if errors are found. 

Use this feature any time you think something might be wrong (for example transaction differences) 

The Recheck accounting (Shift+F9) from the Account1 menu will proceed to a complete controll 

of your accounting file, by executing the following operations: 

 cancel all the accounts balances 

 recalculate and recheck all the transactions 

 recalculate and recheck all accounts and groups 

 recalculate all classes of the Totals table 

 recalculate the amounts of the Balance column in the Transactions table (Cashbook) 

 recalculate the amounts of the Calculated balance (Multicurrency accounting) 

 if errors are found in the Transactions table, a message will be shown 

 if errors are found in the Categories table or in the accounting plan, a message will be shown 
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If, after having rechecked the accounting should some transaction differences be pointed out, they 

can be found with the Search for transaction differences command. 

  

Balancing the opening balances 

At the opening, the amounts of the Total Assets should correspond to the Total Liabilities, 

otherwise it is not possible to have a correct balancing. You need to check that in the information 

window there is no Opening balances difference message. If there is, you first need to correct the 

opening balances of the Balance Sheet so that the Total Assets balances the Total Liabilities. 

(Opening balance column). 

In the following example the program shows an error message reporting a difference of 450.- USD. 
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After having corrected the opening balances the Total Assets must correspond to the Total 

Liabilities. 

 

It is also possibile to check the balancing in the Totals table. 
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5.5.1 Differences in the transactions 

When, after recalculating, there are accounting differences in the Transactions table, the program 

gives the amount of the difference in the information window on the lower part of the screen. Very 

often these differences are due to incomplete recordings.  

By selecting the Search for transaction difference command in the Account1 menu, the program 

shows the row that is at the origin of the possible difference.  
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5.6 Printouts 

5.6.1 Enhanced Balance Sheet 

The Balance Sheet represents all the Assets, Liabilities, Expenses and Income in a specific moment. 

The difference between Assets and Liabilities gives the personal capital. 

The grouping of the accounts is done according to the contents of the BClass column. 

The Enhanced Balance Sheet, shown in the preview, can be saved in different formats (PDF, 

HTML, MS Excel) and can be copied in the clipboard. 

In order to calculate, display and print it at the end of year or the end of a period, activate the 

Enhanced balance sheet command from the Account1 menu.  

The following window, in which several printing options can be activated, appears: 
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Page header 

Rows 1 thru 4 

In this field, enter texts to use as headers when printing. 

Print cover page / Print date / Print page numbers 

The activated options will be shown in the print-out. 

 

Column header (Balance / Profit and Loss) 

The first two vertical fields refer to the Balance Sheet, the two second ones refer to the Profit and 

Loss Statement. 

Current year  

Insert the final date of the current accounting. 

Previous year 

In this field, enter the final date of the previous year's accounting. 



147 

B A N A N A  A C C O U N T I N G  

 

Print pages 

By selecting the appropriate cells, it is possible to choose the options that should be activated in the 

printouts. 

  

Other tabs 

The explanations for the other tabs are available at the following pages: Period, Style, Texts, 

Margins, Composition. 

 

Results 

Assets and Liabilities 
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Expenses and Income 

 

5.6.2 Enhanced Balance Sheet with groups 

The Balance sheet with groups differs from the Balance sheet for the following characteristics: 

 Includes groups and subgroups in the printout, as in the chart of accounts. 

 Offers the possibility to exclude groups or accounts (for instance, only the total of the group 

and not the accounts of which the total is composed). 

 In the Chart of accounts - Sections it is possible to select which accounts to include or 

leave out in the printouts 

 It is possible to choose, for a given period, what kind of subdivision you want (for example 

in the first semester, obtain the data by month or by quarter) 

 It is possible to have a subdivision by segment 

In order to obtain and print the Enhanced Balance sheet by groups click on the Enhanced balance 

sheet with groups command from the Account1 menu; the following wintow ill appear: 
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In the following pages you will find information of the different sectons of the active window. 

  

Example of a printout with an Enhanced balance sheet by groups 
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5.6.2.1 Heading 

 

Header 1, Header 2, Header 3, Header 4 

Enter as headers the text you wish appearing in the printouts. They will be on the cover page and on 

each page headings. 

Print cover page, Print page numbers, Print date  

By activating these fonctions, the cover page, the page numbers or the date will be printed. 
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5.6.2.2 Layout 

 

Zoom 

The printout layout will change according to the entered value. 

Page orientation 

You can select the page orientation: automatic, landscape and portrait. 
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5.6.2.3 Margins 

 

Top, Bottom, Left, Right 

It's the distance between the page border and the content. 

Header 

It's the distance between the page header and the content. 

Footer 

It's the distance between the page footer and the content. 

Increase margins to printable area 

If the content exceeds the page margins it will be automatically adjusted to fit the printable area. 
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5.6.2.4 Sections 

This section can vary depending on the settings of the chart of account - Section colum. Please 

consult the related document: Sections in the chart of accounts 

 

Section 

Depending on the selection, there are different sections with different options: 

     those with an asterisk refer to the section's header 

     sections 1, 2, 3, 4, 01, 02, 03, 04... refer to the main items of the Balance Sheet 

     account sections refer to the selected account 

     group sections refer to the selected group 

  

If you select a section with an asterisk, you will have the following options: 
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Hide section 

Click on the section that you wish to hide. 

Hide current row 

Click on the row that you wish to hide. 

Start on new page 

Click on the header that you want to have on a new page and activate the option. 

Alternative text 

Enter an alternative text if you want to have a different one for the selected section or row. 

 

 

If you select a number section (1, 2, 3, 4.....), there is an extra option: 

 

Group for % calculation (%) 

It is possibile to indicate which group the % calculation should be based on. 

  

  

If you select an account section, you will have the following options: 
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If you select a group section, two extra options, specific for the group, will be shown: 

 

Hide child rows 

Activate this option if you do not want to show the selected group's child rows on the Balance sheet. 

Show as account 

Activate this option if you want the selected group to be show as an account in the Balance sheet. 
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5.6.2.5 Rows 

 

Accounts, accounts with zero balance, accounts with transactions, groups with zero balance, 

empty rows. 

By activating the different options, you can include them in the printouts. 
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5.6.2.6 Columns 

 

The following options are the same for the Balance section, for the Profit and Loss Statement 

section and for the Notes section (shen present); they however vary a little: the Profit and Loss 

section has the Budget fonctions. 

  

Each section has the Advanced button from where it is possible to change the columns settings and 

options. 

  

5.6.2.7 Columns - advanced 

By pressing the Advanced button it is possibile to change the Column, the Headers and the Colors 

settings: you just need to double click on the column name to access to its Properties (you can also 

press on the Properties button). 
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5.6.2.8 Columns - properties 

 

Headers 

Row 1/ Row 2 / Row 3 
It is possible to change the columns headers by selecting the Text option (from the drop down 

menu) and by entering the new header. If you select the Column option, the column name of the 

selected column will be shown. 

 



160 

B A N A N A  A C C O U N T I N G  

 

Options 

Visibile 

If this cell is activated, the column header will be shown. 

 

Display only in the series of totals 

If activated, this option only show the amounts in the Totals column. 

  

5.6.2.9 Columns - add 

Add / Delete 
In the Balance sheet, Profit and Loss Statement and in the Notes, it is possible to add new columns 

(from the ones included in the list), or to delete the undesired ones. 

 

5.6.2.10 Text & Background colours 

With a double clickon the Colours column you can have access to the options to edit both the text 

colour and the background colour. 

You can access this window by pressing on the Properties button, Colours tab (from the 

Enhanced balance sheet by groups command - Columns, from the Account1 menu) 

With the Default colour button, the default settings will be restored. 
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5.6.2.11 Subdivision 

 

None 

The whole period is shown. 
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Subdivision by period 

This function makes it possible to display the dates of the selected period per day, month, bi-

monthly, per quarter, per 4 months, per semester or per year. The selected period will be shown in 

the column headers.  

Only segment 

The data related to the selected segment are being shown.  

Create periods for the whole year 

When the accounting period is not the same as the solar year, but when the user still wants to see all 

months, this function needs to be activated.  

Totals column 

This function creates a Totals column for the selected periods in the Profit / Loss Statement and in 

the Totals view of the Accounting reports command (Account1 menu). 

Max number of divisions 

The default maximum number of periods is 36. In particular cases, if the user would want to obtain 
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special and very detailed statistics over a long time span, this value can be changed manually. A 

very high maximum number of periods can slow down the program. 

 

Subdivision by segment 

The data related to the selected segment are being shown. 

 Select all - all the options will are selected 

 Void - only the amount not assigned to any segment is shown 

 Segments subdivision - Each subdivision will have the heather given in the accounting plan. 

The data of the selected subdivision are shown. 

Totals column 

When this option is being activated, the totals for the selected segment will be obtained. 
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5.6.2.12 Style Tab 

 

Use style 

There are different models of the Enhanced balance sheet provided. By selecting one, the user can 

obtain the Enhanced balance sheet of his choice.  

Style property 

For each style, the color of the fonts and the backgrounds can be defined.  

Value / Change... / Default 

These functions allow the user to change style or to restore the default style.  

Ignore line formatting 

If this function is activated, the formatting will not be maintained. 
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5.6.2.13 Texts  

 

This tab is used to alter the texts of the Value column that the program uses as default headings for 

print-outs. 

In order to change them you just have to double-click on the cell you want to edit. 
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5.6.2.14 Number formats 

 

Divide by 1,000 

If there are big amounts, by activating this option, three zeros will be taken off. 

Show cents 

By activating this option the cents will be shown. 

Show zero amounts  

By activating this option it is possible to choose between having the zero amounts shown with the 

0,00 number or with the -,- symbol. 

Negative numbers 

Negative amounts can be shown with a minus sign before the amount, after the amount or the 

amount can be shown between parenthesis. You can also activate the option to have the negative 

numbers shown in red. 
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5.6.3 Journal 

With Banana Accounting the Journal corresponds to the Transactions table. It is possible to print 

the whole journal or just a part of it, selecting the rows that you wish to print. 

In order to personalize the journal printout you can change the columns order and headings: you can 

find all the information on how to proceed in the Columns setup page; you can also choose several 

options in the printout; please visit the Page setup page. 

 

There are different ways to print: 

 place yourself in the Transactions table and click on the Print icon 

 place yourself in the Transactions table and launch the Print command form the File menu 

 from the Account1 menu click on the Print journal by period command; in this case you 

should then indicate if you wish to print the whole table or just a specific period 
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The information on the Period tab are explained in detail in the Period page of the General settings. 

In the Sort column tab in is possible to choose the criteria the journal should be sorted and printed. 

 

The information on the Sort column tab are explained in the Sort fields page of the accounting 

cards/categories. 

  

5.6.4 Accounting report 

This command allows the user to visualize the amounts of accounts with a specific grouping, for a 

specific period or with a specific subdivision. 

In order to calculate, obtaine and print reports, choose the Accounting reports command form the 

Account1 menu. 
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Base tab  

Report 

You can select the desired grouping scheme: 

 As on Accounts table - the Report will show a list of all accounts just as in the Accounts 

table with the Opening balance and Balance columns 

 Accounts by class - the Report will show the list of the accounts but without subgroups 

 External accounting report - the Report will show the data according to a grouping system 

preset in a separate file (File menu, New command, Other group, Accounting Report). 

Options 

You can select the accounts to be included or excluded: 

 Show group totals only - only the group totals will be shown 

 Include accounts with no transactions - accounts with no transactions will be printed as 

well 

 Include accounts with 0 balance -  accounts with zero balance will be printed as well 

 Exclude groups without accounts - groups with accounts with zero balance will not be 

printed. 

  Other tabs  

The explanations for the other tabs are available at the follwing pages: 

 Period tab 

 Subdivision tab 
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 Composition tab 

  

Report result  

A new table is created where the results are shown. 

 

5.6.5 External accounting report 

The External Report allows the user to regroup an already existing Chart of Accounts with 

groupings according to different set ups and requirements, without having to adjust the Chart of 

Accounts of the main accounting. 

How to create an external accounting report file  

 it is first necessary to create an External accounting report file with the desired accounts and 

groupings: File menu, New command, Other, Accounting Report 
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 You can select a preset example (External accounting report) and modifiy according to your 

needs, or you can choose a new blank file 

 Setup the desired groupings 

  

How to create the groupings in the external accounting report  

If you have chosen the New blank file, you need to proceed as follows: 

 Setup the desired accounting groups 
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Enter in the accounting plan the external accounting report groups  

Open the your accounting file and, in the Accounts table, in the Gr1 or Gr2 column, enter the same 

groups as the external accounting report file. If the Gr1 or Gr2 column is not visible, use the 

Columns setup command from the Data menu. 
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Calculate the external report  

In order to obtain the external accounting report, choose the Accounting reports command from 

the Account1 menu and, in the dialog window that appears choose the External accounting report 

option (you have to select the accounting report file). 
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You can find the explanation of this window at the Accounting report page. 

  

Report result  
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5.6.6 Account/Category cards 

The account card gives a complete list of the accounting transactions for an account listed on the 

Chart of accounts. There are two ways to open an account or a category card: 

 On the account number cell there is a small blue arrow; click on it just once in order to 

obtain the account card 

 

 Select the Account/Category Cards command (Cash book and Income & Expense 

accounting) or Account Cards command (Double-entry Accounting) from the Account1 

menu, in order to open, print all accounting card or just some of them. 

New: update the accounting card 

The account card table is temporary and it is calculated when the command is given to do so. If 

transactions are altered or added, they are not automatically updated on the account card - the user 

needs to select the Account Cards command again or click on the account number blue arrow 

again or click on the small Refresh button on the left side. 

 

From the account card, double-click on the row number to go back to the original line on the 

Transactions table. 

  

The contra account in the account cards 

In the Account cards, the Contra Account column (C-Acct.), which indicates the account that 

completes the transaction, is being shown. 

When there are transactions on multiple accounts (transactions on multiple rows), and there is one 



177 

B A N A N A  A C C O U N T I N G  

account entered in debit and several accounts in credit, or the other way around, the software 

deducts the possible contra account using the following logic: 

 The first transaction row is considered the contra account of the transactions that follow. 

 On the Account card of the first transaction row, the contra account is indicated with the [*] 

symbol, which means that we are dealing with a transaction on multiple accounts. 

 On the Account cards of the next transactions, the contra account is indicated between 

square brackets ("[1020]"), and indicates a deducted contra account. 

 

In this case it is not possible to have the contra account shown in the account card because the 1020 

accounts has multiple contra accounts. For this reason in the contra account column the program 

shows the [*] symbol. 

 

If however you click on one of the accounts with the same contra account, this will be shown in 

between [ ]: 
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Print all account cards 

From the Account1 menu choose the Account cards command; activate the desired options (for ex. 

period, 1 account per page, ...) from the different tabs, and then press OK. 

 

For the explanations of the different tabs, please visit the next few pages. 

The program will show the selected account cards. 
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In order to print choose the Print command from the File menu. If you have to change some 

account cards option, you can directly access the command from here by clicking on the Refresh 

symbol indicated by the arrow. 

Related documents: Page setup, Composition 
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5.6.6.1 Accounts/Categories tab 

 

Accounts 

All the accountsare automatically selected. 

Categories 

All the categories are automatically selected, excluding Cost centers. 

Cost centers 

If the user clicks on this button, only the Cost center accounts are automatically selected. 

Select All 

If the user clicks on this button, everything is automatically selected. 

Deselect all 

If the user clicks on this button, all previous selections are cancelled. 

  

5.6.6.2 Period tab 

The explanations of the Period tab are the same as those for the Save file in Pdf - Period tab. 
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5.6.6.3 Options tab 

 

Lines before end of page 

This function was created in order to avoid printing an account partially on one page and partially 

on the following. If the account card to be printed doesn't have at least a number of lines 

correspondent to the number input in this field, printing the whole card will be moved to the next 

page. 

One account per page 

By activating this function, each card will be printed on a separate page (even those with few 

transactions). 

Repeat column's headers 

By activating this function, the column headers will be repeated for each account, within the page. 

Include accounts with no transactions 

By activating this function, cards without transactions will be printed as well. 
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5.6.6.4 Sort Column 

 

Transactions can be sorted according to different date criteria. If no criterion is specified, the exact 

order that exists for the transactions will be maintained. 

Note: in order to print the account cards, once all the paramethers are being setup, by clicking on 

the OK button they will be shown on screen. To proceed just launch the Print command from the 

File menu. 

  

5.6.7 End of Year PDF printouts 

From the print preview of a document, you can save in pdf format and print. 
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You can save in a PDF format the follwing documents: 

 Balance sheet and Profit and Loss Statement 

 Accounts, Transactions, VAT, Totals tables 

 VAT Reports 

 Account cards 

This PDF file will have an index that will allow to access easily the different printouts. 

If you save this file on a non rewritable CD (to be kept along with the accounting documents), you 

will meet the law requirements for accounting data archiving. 
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5.7 Themes 

5.7.1 Bank checks 

To enter issued bank checks, the user needs to insert an Issued checks account in the Liabilities.  
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The check is issued at the moment of paying a supplier and later on is being debited from the Bank 

current account. 

 

The Issued checks account card after the transactions.   
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5.7.2 Organize yourself 

At the basis of the accounting, there are the accounting documents and receipts. 

The type of one's organizing with regard to the accounting, depends on the size of the activity and 

the amount of documents. 

The way one organizes things has to be adapted to what is needed. 

We are listing down below an indication of possibilities that have proven to be very useful. 

  

The different types of documents 

It is important to distinguish and organize specifically the different types of documents. 

 Basic documents: contracts for rent, telephone subscriptions, statutes, insurance contracts 

and everything that gets signed only once and is valid for several years.These documents 

need to be kept in a separate folder or binder, containing just this type of documents. For 

some of these very important documents (like receipts for down payments, etc) it may be 

useful to make a photocopy and keep the original in a safe or a safe place. Don't make holes 

in important documents, but put them in transparent plastic folders. This binder is the basis 

of your activity/company and you need to handle it carefully. 

 Documents related to employees: Contracts, insurances related to personnel, and other; it 

is useful to keep these in a separate binder. 

If there are lots of documents, we advise you to use one binder per theme. 

 VAT Declarations: it is good to keep a special binder with the different declarations that 

you present at a regular basis (quarterly, by semester or yearly). For your VAT inscription or 

other general documents, it is better to keep them together with the basic documents. 

 Accounting receipts and documents of the year: these are receipts, invoices or other items 

that are related to an expense or a receipt. These have to be kept separately, year by year. 

For every year you will have a binder with these kinds of documents. 

  

Accounting documents 

A good day- to-day order is needed in order to enter the accounting transactions and to control the 

situation of the company, such as the cashflow, the totals of debtors and creditors, etc. 

1. All accounting documents (receipts, invoices, tickets) usually have to be kept for a 

minimum of ten years. 
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2. Classify and put the accounting documents in order by date, together with the related bank 

statements for the payment or the receipt. 

3. Write a progressive number on the accounting documents (statements and others). With this 

number, that should be inserted in the Doc column, you can locate the accounting document, 

with the accounting as a starting point. 

4. At the end of the year, print a copy of the journal and keep it together with the accounting 

documents. 

5. Usually a new binder is being used for each year for the accounting documents. 

 

Issued invoices or receipts with an accounting at the moment of payment 

Small companies and associations enter the invoices only in the accounting at the moment of 

payment (cash method). 

1. Separate the issued invoices and those for which you have received the payment. 

2. Verify regularly the invoices on hold for which payment still needs to be received. As soon 

as the due date for the payment has passed, it is useful to send a payment reminder. Don't let 

too much time pass by, make sure you receive the payment for unpaid invoices. This takes 

time, but is it important. 

3. Once these invoices are paid, put them together with the normal accounting documents. 

 

Issued invoices or receipts with an accounting on the sales volume 

The invoices are being registered at the moment they are issued as well as at the time of payment. 

See also: Clients/Suppliers Registers 

1. Separate the issued invoices and those for which you have received the payment. 

2. Verify regularly the invoices on hold for which payment still needs to be received. 

As soon as the due date for the payment has passed, it is useful to send a payment reminder. 

Don't let too much time pass by, make sure you receive the payment for unpaid invoices. 

This takes time, but is it important. 

3. When you enter the issueing of the invoice in the accounting, make note of the registration 

on the invoice. On the transaction row, use the "Doc. Original" column to insert the invoice 

number. 

4. Once the are invoices are paid, move them over to the "paid" section, and enter them in the 

accounting. 

5. When you have entered them, make note of the accounting transaction on the invoice (for 

example with a "checked" sign) 

 

Transactions / frequence 

 It is good to regurlarly enter the transactions in the accounting (daily, weekly, monthly). 

 We strongly advice you to not neglect entering the accounting transactions, so that you 

always have updated information and can evaluate the progress of your activity. 

 By going over the different expenses account numbers, you can easily have an overview of 

the different expenses that you made. 

 The accounting is not just done for the tax authority. 

5.7.3 Clients/Suppliers register 

The Clients/Suppliers registers can be set up in two different ways: 
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 Clients/suppliers register with accounts in the Balance sheet 

 Clients/suppliers register with Cost centers 

Accounts with addresses  

It is possible to Add columns with addresses in the Accounts table, so for each account can be 

entered the address personal data. 

Clients/Suppliers registers with accounts in the Balance sheet  

This solution is the most used one and it is absolutely necessary if you need to register the issue 

invoices or receipts with an accounting on the sales volume. 

  

Clients management 

 The clients account are normal accounts in the accounting plan 

 In order to avoid having in the accounting plan all the clients list, we just create the Total 

Clients Register group (group 10 in the example) 

 The clients account are placed at the bottom of the accounting plan 

 At the bottom of the accounting plan a new row is created with the 01 Section and a Clients 

Register description 

 A new account is created for each client 

 A total clients group is created at the end of the clients list (for example with the group 

symbol TCR) 

 All clients account must have 1 (Assets) as Bclass and TCR as group 

 As clients account numbers you can use either numbers or letters 

 The TCR group must have a 10 as group, so its amount will be carried to the top of the 

accounting plan 

In this way, when printing the Balance sheet you won't have to print all the clients list but only the 

Total Clients Register. 

  

Suppliers management 

The suppliers managements works exactly as the clients management but with the difference that 

the Total Suppliers Register must be created in the Liabilities and that the suppliers account must 

have 2 as Bclass. 

  

Example images for clients/suppliers register with accounts 
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The Total Clients Register group is created in the Assets. 

 

The Total Suppliers Register group is created in the Liabilities. 
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The list of clients accounts and suppliers accounts is created at the bottom of the accounting plan. 

The Gr of the clients and suppliers register needs to be the same as the Group number set up in the 

Assets and the Liabilities (in the example 10 for the Assets and 20 for the Liabilities). 

  

Transactions 

When client or supplier transactions are entered in the Transactions table, the client or supplier 

account needs to be indicated. 

  Clients/Suppliers registers as Cost centers  

The client/supplier registers can also be set up using the Cost centers (please also visit the Cost and 

Profit centers page) 

 we suggest to use che CC3 Cost center (where their symbol is preceded by a ";") 

 clients and suppliers balances won't be shown in the Balance sheet 

Cost center accounts for clients and suppliers are being created by using the CC3 cost center: 
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Transactions 

When entering transactions: 

 make the CC3 columns visible by using the Columns setup command from the Data menu 

 enter the cost center code in the CC3 column 

 in order to enter the credit account, use a minus sign (-cost center code) 

 if you have VAT management, in the File properties - VAT tab, you need to indicate that the 

CC3 cost center must Use amount inclusive VAT/Sales tax 
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5.7.4 Membership list 

In order to obtain the membership list with all the data that are useful for an association, the user 

needs to proceed as follows: 

 In the Accounts table, at the end of the Chart of Accounts, the membership list can be 

created by using the CC3 cost center column. 

 

 Activate the Address view, selecting from the Tools menu, the Add new functionalities 

command 

 In the window that appears, confirm the option Add addresses columns in Accounts table 

 Insert the data of the members 

 For a print-out: select the rows that need to be printed and activate the printing option only 

Selection. 

 

In order to record the transfers from every member in the Transactions table, insert the CC3 account 

for each member, using the CC3 column. In order to display the CC3 column, click on the 

Columns setup command of the Data menu; double click on CC3 and activate Visible check box. 
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In the Accounts table, the balance of the member's transactions is shown. 

 

To see all of a member's transactions, double-click on the CC3 account number. 

 

Related document: Cost and Profit centers 

  

5.7.5 Managing different projects 

With the Segments feature, it is possible to manage different projects, obtaining balance sheets that 

determine the profit or the loss of each project.  

  

Example 

In an association, there are two projects that need to be managed: 

1. Courses 

2. Manifestations 

On top of that, there are different branch offices with the same projects to be managed: 

 Rome 

 Palermo 

 Florence 
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The user wishes to obtain a balance sheet which indicates the profit or the loss of each project and 

branch office.  

  

How to proceed: 

 Insert the segments at the end of the chart of accounts 

 

 Enter the transactions, and complete the debit and the credit accounts with the segments 

 

 From the Account1 menu, activate the Enhanced balance sheet by groups command 

 Select the available configurations in the different tabs; in the Sections tab in particular, 

deactivate the display of the Balance sheet accounts, the Client/Suppliers accounts and the 

Cost centers. The segments usually refer to the accounts of the Profit & Loss statement. 
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 In the Subdivision tab, activate the Subdivision by segment option 

 Select the segment for which the balance sheet should be obtained (by project or by branch 

office) 
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 Click on the OK button in order to display the report 

Report by projects 
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Report by branch office 
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Report of both Projects and Branches 
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5.8 End of the Year closure and New Year 

At the end of every accounting year, before printing the reports, it is necessary to recheck the 

accounting file. 

Please visit the Recheck the accounting page. 

Create a New Year  

At the end of the accounting year, the program gives the possibility to automatically pass on the 

new year, even without having allocated the profit or loss of the year that just ended. 

With this operation the program 
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 creates a new file (with no name) with the accounting plan and all the settings identical to 

your current file, but without transactions 

 Copies the amount from the Balance column of your current file to the Opening Balance 

column of the new file (only for the selected classes) 

 Adds the selected amount to the Profit or Loss from previous year account in the new file 

 Updates the opening and closing dates in the File and accounting Properties of the new 

file 

Create New Year command  

 Open the current file and click on the Create New Year command from the Account2 

menu: a window, that shows a difference corresponding to the profit or loss that has not yet 

been allocated, will appear. There may also be differences due to accounting errors. 

 From the list that appears, the user can select the account to which the result of the 

accounting period has to be allocated, or one can directly confirm with OK if the allocation 

of the result has to be postponed. 

 

Carry forward account opening balances 

The opening balances of the selected options are carried forward. 

Indicate which accounts are required to have opening balances carried forward. Usually the Profit 

and Loss Statements balances  are not carried forward. For specific needs you can always activate 

the option. 

Allocation profit/loss 
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Total to allocate 

The program will indicate the profit/loss that needs to be shared between various accounts. 

Accounts/Amounts 

You need to indicate to which account(s) the profit or loss should be shared with the relative 

amount. If only one account is selected, the amount will automatically entered. If three accounts are 

not enought, then it will be necessary to manually correct the amounts on the new accounting in the 

opening column. The program will automatically update the opening balances. The Total Assets 

will match the Total Liabilities. 

 Confirm the File and accounting properties for the new year 

 

 From the File menu, activate the Save as... command, indicating the folder where the new 

accounting file needs to be saved. 

Updating opening balances command  

In case the previous year has been closed and changes have been made afterwards, the opening 

balances of the already opened new year need to be updated. The updating process is the same 

operation as the Create New Year. 

 you need to specity the file you need to update the balances from 

 the closing balances of the selected file will be carried forward to update the opening 

balances of your open file 

Opening balances must be uptated in the following situations: 

 when you made corrections in the previous year to correct differences 

 when you made changes in the previous year transactions 

 when the profit/loss of the previous year has not been allocated 
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Here is how to proceed to make the update: 

 Open the current year accounting file and choose the Update opening balances command 

from the Account2 menu 

 

 Select the previous year accounting file through the Browse button 

 Follow the same steps as the Create New Year command (see top of the page) 

  

6 Multi-currency accounting 

Multi-currency accounting is based on the double-entry accounting method and can also manage 

accounts and transactions in foreign currencies. 

Many topics of the multicurrency accounting are the same as the double-entry accounting. In order 

to find missing lessons or in-depth information, we advice you to consult our internet pages on the 

Double-entry accounting. 

  

Characteristics  

 Manages the estate accounts and profit/loss accounts (assets, liabilities, expenses and 

income) in foreign currency 

 Calculates the conversion automatically, based on the exchange rate inserted in the 

Exchange rate table 

 Calculates the exchange rate differences automatically 

 Offers Balance Sheets and Profit and Loss Statements in a second currency as well. 

  

Chart of accounts, file properties and echange rates table 

We suggest to choose one of the already configured examples and to personalize it according to 

your needs. Please note that the chart of accounts must include the account for profit and loss from 

exchange rate variation and there must be accounts in foreign currencies. 

 Setup the chart of accounts 

 Groups and subgroups 

 File properties - foreign currencies tab 

 Setup the exchange rate table 
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Transactions 

Accounting transactions must be entered in the same way as the double-entry accounting 

transactions 

 Transactions in basic currency 

 Transactions between accounts in basic currency and accounts in foreign currencies 

 Transactions between two different foreign currencies (no account in basic currency) 

 Register exchange rates differences 

  

Printouts 

 Account cards 

 Journal 

 Enhanced balance sheet 

 Enhanced balance sheet with groups 

 Accounting reports 

  

6.1 Starting a multi-currency accounting  

When starting to work with Banana multi-currency accounting, we suggest to choose one of the 

already configured examples and to personalize it instead of starting from a new blank file: 

 Choose the New command from the File menu and select the Multi-currency accounting 

type (with or without VAT management); then select the Example/Template that most suits 

your needs. 
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 Enter the basic data in the File and accounting properties window from the File menu 

 

File and accounting properties - Foreign currency tab  
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Account for exchange rate profit 

From the accounts list, select the one for the exchange rate profit. 

Account for exchange rate loss 

From the accounts list, select the one for the exchange rate loss. 

Currency 2 

It is possible to select a second currency in order to view the balances in a currency different from 

the basic one. 

Exchange Rate rate valid even from basic currency 

If this option is checked, the program will use the last entered exchange rate in the Exchange rate 

table (Exchange rate column). 

 

You have to set up the chart of accounts making sure that there are accounts in foreign currencies 

and that there are accounts for the profit and loss from exchange rate variation.  

  

6.2 The multi-currency chart of accounts 

Setup the chart of accounts  

The assets and liabilities accounts can be setup in any foreign currency, but in the chart of accounts 

the Currency column has to contain a currency symbol that has been previously defined in the 

Exchange rates table. The grouping system is the same as the one explained for the double-entry 

accounting. 

In the following examèle the basic currency is USD. 
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Income and expenses 

The accounts of the Profit and Loss Statement (Expense and Income) have to be specified in basic 

currency. 
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I saldi di apertura  

The first time Banana accounting is being used, after setting up the Chart of accounts, the user 

needs to insert the Opening balances. 

 The Opening balances have to be inserted in the Accounts table, in the Opening currency 

column, Base view. This operation needs to be done for both basic curreny and foreign 

currency accounts. 

 The opening balances for the liabilities have to be entered with the minus sign (-) before the 

amount   

 The opeing balances of assets and liabilities have to balance out; for more information 

please visit the Recheck the accounting page. 
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6.3 Exchange rates table 

Before entering multi-currency transactions it is necessary to define the parameters of the used 

currencies in the Exchange rates table. 

The first time you use Banana Accounting, you need to enter for each currency the opening 

exchange rate, that sould correspond to the closing exchange rate of the previous year. 

The Opening exchange rate should never be modified during the year, otherwise differences in the 

opening balances will show up.
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Date 

This is the date when the exchange rate was used. The program only uses exchange rates with no 

date. The date column is only used in the exchange rate history. If a date is entered in the Exchange 

rates table, the program will not use the exchange rate, and the following message will appear in the 

Transactions table: currency symbol not found. 

Currency Ref. 

This is the currency that serves as the basis for the change (the Euro in our example.) 

Currency 

This is the destination currency, the one into which the value of the “Currency Ref.” will be 

converted. 

Text 

A text to specify exactly which foreign currency is being dealt with. 

Fixed 

True or false. If there is a fixed exchange rate, enter Yes in this column. In this case, the exchange 

rate used will not be the opening one, but the rate specified in the Exchange Rate column. 

Mult. 

The multiplier is usually 1, 100 or 1000 and is used to obtain the effective exchange rate. The 

multiplier is used for currencies which have a very low unit value in order to avoid having to insert 

exchange rates with many zeros. The multiplier can also be negative (-1). In this case, the program 

will use an inverted exchange rate or else it will act as if the currencies inserted in the Currency and 

Reference Currency columns had actually been inverted (exchange rate = 1/exchange rate). Do not 

alter the multiplier once there are already transactions in the same currency. The program will 

signal a transaction error due to erroneous exchange rates. 

Exchange rate 

This column shows the actual exchange rate for the currency with respect to the reference currency. 

Opening Exchange rate 

This is the exchange rate at the moment the accounting is opened. It is used to convert the opening 

amount of the currency into the opening amount of the accounting’s basic currency. Insert it only 

once when the exchange rates are input because the program will then pick it up automatically at 

the beginning of a new year. 

Minimum 

This column shows the minimum exchange rate accepted. If a lesser exchange rate is used during 

the entry, there will be a warning. 

Maximum 
This column shows the maximum exchange rate accepted. If a greater exchange rate is used during 

the entry, there will be a warning. 

Decimal Points 

This column shows the number of decimal points to be used when rounding the amounts in 

currency2. 
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6.4 Transactions 

Establishing the exchange rate 

Before entering a transaction in foreign currency, the Foreign Exchange Rate table needs to be 

updated (Exchange rates column) with the daily exchange rate. In the Transactions table, the 

program calculates the exchange values according to the inserted exchange rate, and takes the 

eventual exchange rates profits or losses into account. The exchange rate difference depends on the 

exchange rate inserted in the Foreign Exchange Rate table. 

Every day there is a different exchange rate and thus also the values of the Balance Sheet change on 

a daily basis. Except in special cases, the Foreign Exchange Rate table doesn’t need to be updated 

every day.  

 

Types of entries allowed 
For each entry there are two accounts (debit account and credit account) and there can be the 

following direct combinations: 

 Entries between two accounts in basic currency (USD-USD)  

 Entries between an account in foreign currency and one in basic currency (EUR-USD) 

 Entries between two accounts in the same foreign currency (EUR-EUR), but not in basic 

currency. It is not possible to register a transfer between two accounts in different foreign 

currencies in a single row when none is the basic currency (EUR-YEN). 

Important: every amount, either in basic currency or foreing currency, must be entered in the 

Currency Amount column only; the  expenses and the income need to be entered with the daily 

exchange rate and thus have to be in basic currency.  

  

Exchange rate to be used 

For certain operations you need to keep in mind that it might be necessary to use a predefined 

exchange rate (banking transactions). In these cases you need to use the indicated rate and the 

program will automatically calculate the exchange value in basic currency. Banks specify exchange 

rates with few figures after the decimal point and often round the amounts. On these occasions you 
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input the exchange value in basic currency and leave it to the program to work out the actual 

exchange rate.  

The exchange rate used can influence the calculation of VAT. If you invoice goods to a customer 

from your country in EUR, the calculation of VAT will be made on the USD exchange value. The 

exchange rate used will determine the amount of VAT due. National VAT legislation will tell you 

which exchange rates to use under such circumstances.  

Other factors can determine the exchange rate to be used. For some kinds of transactions, loans and 

shares, the exchange rate of the time of purchase (historical one) is often used, independent from 

exchange rate fluctuations.   

  

Manually inserted Exchange rate 

When it is necessary to insert an exchange rate directly in the Exchange rate column (Transactions 

table), different from the one in the Exchange rate table, the user must, in order to calculate the 

amount in basic currency, put himself in the cell of the Exchange rate column and press the F6 key. 

To accelerate entering the transactions, consult the first paragraph of our online lesson Transactions. 

  

Error message: Currency symbol not found 
In version 4, the absence of a currency symbol in the Transactions table was interpreted as a 

transaction in Basic currency. 

In version 7 every transaction needs to have its own currency symbol. Thus, when passing from 

version 4 to version 7,  it is necessary to complete the transactions where no currency symbol has 

been inserted in the accounting file. 

  

6.4.1 Transactions in basic currency 

This is a simple entry with the Debit and the Credit account in basic currency (USD in the 

example). 

 

6.4.2 Transactions between accounts in basic and foreign currency 

This is a typical operation: one account is in basic currency and the other is in a foreign currency. 
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 Enter the exchange rate of the day in the Exchange rates table 

 Enter the Debit and Credit accounts (one of them is in basic currency) 

 Enter the amount in foreing currency 

 

When, from the bank statement you see the exchange rate used for the transaction, you need to enter 

the exchange rate indicated by the bank. 

The program will automatically use the exchange rate entered in the Exchange rates table and will 

enter the amount in basic currency in the Amount column. 

 

Consequences on the accounts cards 

On the 1000 account the USD amount 1'256.88 is shown in the Debit column (Basic Currency 

view)  

 

On the 1025 account the EUR 1000.00 amount in foreing currency is entered in the Credit 

Currency column (Currency view) 
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6.4.3 Transactions between accounts in a foreign currency 

In the following example there is a transaction between two accounts in EUR (foreign currency), 

with no account in basic currency. The amounts are automatically converted in the basic currency 

USD according to the exchange rate entered in the Exchange rates table. 

 

Consequences on the account cards 

On the 1025 EUR account the 1'000.00 EUR amount is registered in the Debit column (Currency 

view). 
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On the 1026 EUR account the 1'000.00 EUR amount is registered in the Credit column (Currency 

view). 

 

In the Basic Currency view we can see that the amounts are automatically converted in the basic 

currency (USD). 

 
On the 1025 EUR account the USD 1'263.90 amount is registered in the Debit column (Basic 
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Currency view). 

 

6.4.4 Transactions between two different foreign currencies 

When there is a transaction between two different foreign currencies (USD and CHF for example) it 

is not possible to make the entry on a single entry row. 

 

You will have to use two entry rows and operate as if you were entering two different operations: 

 Enter on the first row the debit account and the foreign currency amount (CHF in the 

example). 

 Enter on the second row the credit account and the second foreign curreny amount (USD in 

the example). The program will now signal a difference, because the automatically 

calculated amounts in basic currency are different. 

  

 On the second row, copy the amount in basic currency from the former row. (EUR 832.36 in 

the example) and press F6 to calculate the exchange rate. The entry is now complete and 

there are no accounting differences. 

 

  

Effects on the Account cards 
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On the 1025 account, the foreign currency amount of 1’000.00 EUR is being entered on the debit 

side (Currency view) 

 

On the 1030 account, the foreign currency amount of 1'202.04 CHF is being entered on the credit 

side (Currency view).  

 

  

  

  

6.4.5 Register exchange rate differences 

In order to calculate the exchange rate differences, the account or the accounts for the exchange rate 

differences has/have to be present in the Chart of accounts. Also, in the File and Accounting 

properties of the File menu, these accounts should be indicated in the Foreign currency tab. 
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 Before calculating the exchange rate differences you have to update the exchange rates in 

the column Exchange rates in the Exchange rates table. 

 

  Execute the command Create transaction for exchange rate variation (Account2 menu). 

The software calculates the exchange rate differences automatically. 
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6.5 Enhanced Balance Sheet 

The Enhanced Balance Sheet in the multy-currency accounting is done the same way as the one in 

double-entry bookkeeping. Information is available at the following link: Enhanced Balance Sheet. 

The difference consists in the fact that the foreign currency accounts report the amounts in foreign 

currency aswell as in the basis currency (amount converted). 
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6.6 Enhanced Balance Sheet by groups 

The Enhanced Balance Sheet by groups in multy-currency accounting is done the same way as the 

one in double-entry bookkeeping. Information is available at the following link: Enhanced Balance 

Sheet by groups. 

The difference consists in the fact that the foreign currency accounts report the amounts in foreign 

currency aswell as in the basis currency (amount converted). 
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6.7 Differences in the opening balances 

When, in the preceding year, the exchange rate differences have not been calculated, the program 

signals, in the new year, a difference in the opening balances. In order to resolve this problem, there 

are two possibilities: 

If the preceding accounting year has not yet been audited, calculate the exchange rate differences in 

the preceding year, 

 Insert in the Exchange rate table, Exchange rate column, the official exchange rates at 

31.12  

 Activate, from the Account2 menu,  the Create transaction for exchange rate variation 

command. 

 Open the file for the new year and update the opening balances. 

If the preceding year has already been closed and revised, you must proceed with an adjustment of 

the opening balances of the new year: 

 Open the file of the new year 

 Insert in the Assets or the Liabilities (Accounts table), according to the situation, a new 

account Unrecorded Exchange rate differences 

 In the Opening Currency column, insert the amount corresponding to the exchange rate 

difference. 

 At 01.01, the exchange rate difference account has to be put to zero by means of a 

transaction (Transactions table), using the account related to the exchange rate differences 

(Exchange rate profit/loss) of the profit/loss statement as its counterpart. 
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Adding of the account Unrecorded Exchange rate differences 
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Adjustment Transaction 

 

The account Unrecorded Exchange rate differences has now been put to zero 
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6.8 Accounting Reports 

Accounting Reports in multy-currency accounting are done the same way as the ones in double-

entry bookkeeping. Information is available at the following links: Accounting report; External 

accounting report. 

  

7 Cash book and Income & Expense accounting 

Introduction 

These two types of accounting, the Cash book and Income & Expense accounting, are tailor made 

to manage the accounting of small companies, associations, someone's own business, or for 

projects. They can be configured with or withour VAT. 

The Cash book is used to keep track of the income and expenses of one single account (cash, bank 

account, clients, suppliers, etc.) 

The Income & Expense accounting allows the user to manage income and expenses of several 

accounts. 

  

Table accounts and Categories 

The estate accounts are entered in the table accounts. Only one single account is inserted in the 

Cash book (cash, bank account, postal account ...). In Income & Expense accounting instead, 

several accounts are entered in the table accounts (cash, customers, suppliers...). In the case of 

Income & Expense accounting the opening balances of liabilities accounts have to be entered with a 

minus sign in front (negative). 

Income and cost categories are entered in two main groupings in the table Categories. Sometimes 

they may have subgroups. The together of categories determines the gain or loss of the accounting 

year. 
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Subjects similar to Double-entry accounting 

 Add, cancel an account 

 Rename an account 

 Insert groups 

 Cost and profit centers 

 Segments 

Commands 

 Recheck the accounting 

 Lock transactions 

 Create New Year 

Printouts 

 Registrations 

 Account/category cards 

 Enhanced statement 

 Accounting report 

  

7.1 Getting started 

From the File menu, activate the New command and select Income & Expense accounting. You 

can choose between a Income & Expense accounting with or without VAT/Sales tax. 

In order to facilitate starting, we advice to open one of the existing templates and elaborate the 

necessary adjustments. 

The Cash book and Income & Expense accounting have the same tables: Accounts, Categories, 

Transactions and possible VAT/Sales tax table. The two types differ in the following 

characteristics: 

 In the table Accounts of the Cash book you may insert one single account 

 In the table Accounts of Income & Expense accounting it is possible to insert all the estate 

accounts (assets and liabilities) 

 In the table Transactions of the Cash book there is the column Balance showing the accounts 

balance row by row 

 In the table Transactions of Income & Expense accounting there is no column Balance, 

since the transactions relate to several accounts. The balance is shown in the tabels Accounts 

and Categories. 

 

The following pictures refer to Income & Expense accounting. 



225 

B A N A N A  A C C O U N T I N G  

 

Set up your data from the File and Accounting properties command (File menu) 

 

Insert the opening balances in the Opening column of the table Accounts. Please remember, that 

for the Liabilities' accounts (f.i. debts), the opening balance should be preceded by the minus (-) 

sign. This operation needs to be executed only the first time using Banana Accounting; from then 
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on, every end of the year, when creating a New Year (Account2 menu, Create New Year 

command) the opening balance is automatically transfered. 

 

In the Categories table, arrange the income (earnings/revenue) and expense (expenses/costs) 

categories, assigning each one a code, a description and the belonging group. 

The categories don't have any opening balances at the beginning of the year. 
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In the table Transactions daily income and expense transactions are entered, indicating the account 

to which the transaction was made and the category to which the expense is attributed to. 

 

Related document: Transactions, Enhanced statement. 

  

7.2 Transactions 

The transactions are entered in the Transactions table. 

Insert for every transaction the date, document number, description, incoming or expense amount, 

account and the category. 
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Income/Expenses: the amount coming in or going out. 

Account: one of the estate accounts (cash, bank, post, clients, suppliers,...) is entered. 

Category: an income or expense category is entered 

  

To speed up entering the transactions, consult the paragraph Speed up the input process and the 

Recurring transactions page. 

Attention: to deactivate last year's Smart fill, you have to deactivate the option Smart fill with 

transactions from previous year (File menu, File and accounting properties command). 

  

Examples of transactions without VAT 

 

Examples of transactions with VAT 
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Note: In the Transactions table, instead of the account number you can also find the text you wish 

to find. 

The software will show you the list with all the accounts containing the entered text. With the 

Arrow down key you can move directly in the list. You can select the desired account number by 

pressing the Enter key. 

After having entered the transactions, in order to display the mouvements of an account or a 

category, click on the blue little arrow in the account/category cell: 

 

Account and category card 

In the account or category card, the presentation of the transactions is very similar to the ones of the 

Transactions table. If you enter more transactions or make changes, you can update the 

account/category card by pressing on the Refresh icon on the right side of the screen. 

 

7.3 Printouts 

7.3.1 Enhanced Statement 

The Enhanced Stament gives an overview of the advancement of the estate situation and the 

operating result of the year. This function is present in the Income & Expense accounting. 

The Enhanced Statement is calculated and visualized by means of the command Enhanced 

Statement, from the Account1 menu. 

In the window that appears, you have the possibility to insert the header that appears on the first 

page of the Enhanced Stament; further a series of options can be selected in order to include further 

details in the printout.  
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Page headers  

Rows 1-4 

In these rows, the user can freely define the Statement headers. 

Column header  

Initial date 

Insert the initial date of the accounting. 

Final date 

Insert the final date of the accounting. 

Previous year 

Insert the final date of the previous accounting year. 

Print pages  
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Checking the boxes you define the options you desire to appear in the statement printout: 

Accounts 

The accounts will be printed. 

Initial page 

The initial page with the file headers will be printed. 

Categories 

The categories will be printed. 

End of page after Accounts 

The accounts and the categories will be printed on two different pages. 

Include in printout  

By visiting the boxes you choose the options that must appear in the printout. 

Other Tabs  

The explanations for the other tabs are available at the follwing pages: 

 Period 

 Style 

 Texts 

 Margins 

 Composition 

  

7.3.2 Accounting report 

This command displays the amounts of accounts with a certain group, for a fixed period or for a 

subdivision. 
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Show  

You select the desired grouping scheme: 

 Accounts - the Report will show a list of all accounts with the following columns: opening 

balance, income, expenses and account balance 

 Categories - the Report will show a list of all categories with the following columns: 

opening balance, income, expenses and account balance. 

Options  

You select the accounts to be included or excluded: 

 Exclude accounts - only the categories will be printed 

 Include accounts with no transactions - accounts with no transactions will be printed as 

well 

 Include accounts with 0 balance -  accounts with zero balance will be printed as well 

 Exclude groups without accounts - groups with accounts with zero balance will not be 

printed. 

Other Tabs  

The explanations for the other tabs are available at the follwing pages: 

 Period 

 Subdivision 

 Composition 

7.4 New Year 

You can automatically switch to the New Year in the following ways: 
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 Open the file of the just terminated year and click on the command Create New Year from 

the Account1 menu 

 Confirm the data base of the accounting properties. 

 Save the file with name. 

The program takes over automatically: 

 The account (if it is a Cash book) or the accounts (in case of Income & Expense 

accounting), reporting the opening balances 

 The categories are being taken over without an opening balance, because you start from 

scratch, in order to determine the business result for the current year. 

  

8 VAT Management 

Pages with more in-depth information: 

 VAT management in Switzerland 

There are several pages with specific information for Switzerland, for example on how to set 

up the VAT codes table, enter the VAT transactions and prepare the declaration. 

 VAT management in Italy - this page is in Italian 

 Import VAT codes 

8.1 Theory 

VAT (Value-added Tax) is a tax that weighs on the final consumer. Every VAT subject must 

calculate and periodically deposit the tax to the Revenues Authority. 

Every country has its own VAT rates that are established in different percentages depending on the 

type of merchandise or service. Certain merchandise and services are exempt or excluded. 

The percentages vary according to the financial necessity of the country; therefore, there can be 

changes over the years. 

  

VAT rate 

In this document, to make calculating easier, we will use the following rates: 

 10 % normal rate 

 5% reduced rate 

 0% excluded operations or exempt operations 

   

VAT calculation 

Net Price x VAT Percentage / 100 = VAT Amount 
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Example: 

Net price 300 

Tax rate 10% 

VAT amount = 300 x 10 / 100 = 30 

  

Gross price calculation 

Net price + VAT Amount = Gross Price 

Example: 

300 + 30 =  330 

Sometimes the gross amount is known and it is necessary to find the net and VAT amounts. 

  

Net price calculation 

Gross Price / (100 + VAT rate) x 100 = Net Price 

Example: 

330 / (100 + 10) x 100 = 300 

The net price represents the cost (purchase) or the revenue (sale) of the company 

  

VAT amount calculation 

Gross Price - Net Price = VAT Amount 

Example: 

330 - 300 = 30 

or 

330 - [330 / (100 + 10) x 100] = 30 

The VAT amount represents the debit (sales) or the credit (purchases) towards the Revenues 

Authority. 

  

VAT rate calculation 
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VAT Amount  / Net Amount x 100  = VAT Rate 

Example: 

30 / 300 x 100 = 10% 

or 

[330 - 330 / (100 + 10) x 100]/100 = 10% 

  

Another example: 

20 / 400 x 100 = 5% 

This way of calculating is used when the rate is not known. 

  

8.2 VAT Codes Table 

The VAT Code table setup allows the definition of all the parameters that are necessary to manage 

the transactions with VAT. The setup refers to: 

 VAT due or recoverable  

 Transaction amount recorded as net, gross, or VAT amount at 100% (Customs VAT)  

 Freely definable applicable VAT rates  

 Freely definable account in which VAT must be recorded  

 Special rounding off for each code  

 Definable grouping and totaling method 

The VAT Codes table has a Base view and a Complete view (see the table hereunder). The 

difference between the two is the fact that the Complete view presents several columns that are not 

available in the Base view. These columns serve to accommodate some specific options.   

Calculation modality  

The parameters indicated in the VAT Codes table are being used to calculate the VAT of the 

individual transactions. The parameters established in VAT Codes table cannot be changed in the 

transactions. This modality guarantees that the VAT calculations are correct and uniform. 

Please note: if the values of a VAT Code, which has already been used in the transactions, are 

being modified, the changes are not active immediately; in this case it is necessary to activate the 

Recheck accounting command (Account1 menu -> Recheck accounting). When the VAT Codes 

table is being modified, the program invites the user to execute a complete recalculation as a 

precaution.  
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Detailed description of the columns  

In the following columns, insert the following data: 

 Group: a code or number that identifies the group to which the code belongs. In the 

example we have inserted 1 for the sales, 2 for the purchases, T for the total.  

 VAT Code: the code to identify and carry forward the VAT code in the transactions.   

 Description: a text for the description of the VAT Code or the group.   

 Gr: code of the "Group" in which the row has to be added. 

 Gr1: code for additional groupings. 

 Gr2: code for additional groupings. 

 Due VAT:  

If the word Yes is being inserted, this means that the VAT is at debit (due to the State)    

If the cell is empty, this means that the VAT is at credit (recoverable)  

 Amount type: indicates how the software considers the transaction amount: 

0 (or empty cell) with VAT/sales tax (the transaction amount is considered VAT included)  

1 = without VAT/Sales tax; 

2 = VAT amount (the transaction amount is considered the VAT amount)  

 % VAT: VAT code percentage  

 VAT% on gross: is usually being left empty. In special cases, the word "Yes" has to be 

inserted only if the VAT percentage has to be applied on the gross amount (VAT included) 

and not on the taxable amount.  

 VAT account: the account on which the calculated VAT is being automatically. 

In the File and Accounting properties (File menu), a general account, that will be used as the 

VAT account, can be defined. 

It is also possible to set up a specific account for every individual VAT code. 
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 Round Min: minimum value for rounding, to use only in particular cases. By preference, 

the rounding indicated in the basic data of the accounting (f.i. minimum rounding 

value 0.05) is being used. 

 Don't warn: there are particular transactions that the software could interpret as mistaken, 

but which, in reality, are correct. In order to avoid that the software signals error messages, 

insert the word Yes for the code that is concerned.  

When the transactions with VAT are inserted, by applying the VAT Code in the VAT Code 

column, the software calculates automatically all the amounts related to the VAT and transfers them 

in the VAT account.     

Adding a new percentage   

When a new percentage is added, a new row has to be added; in the new row, insert the data of the 

new VAT code with the new percentage, while paying attention to insert the correct grouping. Don't 

change a code that has already been used in the transactions.    

Groupings  

By creating groups with multiple totalling levels, the user can obtain the totals that are necessary for 

the VAT declaration.    

In the VAT report, by activating the option Use own grouping scheme, the software calculates the 

totals exactly as indicated in the sequence of the indicated groupings in the VAT Codes table.  

The groupings are being used to obtain totals for groups of transactions, for example, the totals for 

all exportations or importations.  

  

Related document: Import VAT codes 

  

8.3 File properties (VAT/Sales tax tab) 

This tab only appears if an accounting with VAT/Sales tax management is chosen. 
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VAT Account 

The Automatic VAT account, that is present in the chart of accounts, is defined here as default. In 

this case, the VAT account does not need to be inserted in the VAT Codes Table. 

VAT/Sales tax rounding 

This is where the user inserts how the VAT/Sales tax amounts should be rounded; if, for example, 

the user inputs 0.05, the VAT/Sales tax amounts will round to multiples of 0.05. 

Cost Centers 1 (CC1), 2 (CC2), 3 (CC3) 

For each type of Cost Center, the user can select which amount to use for the transaction in the cost 

center. 

 Use transaction amount 

 Use amount inclusive VAT/Sales tax 

(When cost centers are being used for Client/Suppliers accounts) 

 Use amount without VAT/Sales tax 

(When cost centers are being used for Revenue and Expenses) 

Note: If one of these parameters is modified, the accounting must be recalculated. 

  

Related documents: VAT Management, Cost and Profit Centers 
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8.4 Associate VAT code to the account 

In an accounting with VAT, the user can, at the moment the Chart of Accounts is created (Accounts 

table), associate a VAT code to the income/expense accounts, so that, when the sales and purchases 

are being recorded, the program automatically inserts the VAT code and completes the columns 

with the VAT data while entering the account number.   

In order to associate the codes: 

 Click on the Other view 

 Insert the VAT codes for the income/expenses in the VAT code column. If the VAT code 

column is not be visible, click on the Data menu, Columns setup command (see Related 

document at bottom of this page). 

. 

Related document: Columns setup 

  

8.5 Transactions  

Before entering the accounting transactions with VAT, the VAT accounts need to be entered in the 

Chart of accounts (our advice is to use an Automatic VAT account) and to update the File and 

Accounting properties, VAT/Sales tax Tab with the Automatic VAT account or the traditional VAT 

accounts (Recoverable VAT and VAT due). 

In the VAT codes table, there are codes both for the sales and the purchases. When entering the 

transactions, use the appropriate VAT code.  
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The software automatically splits the VAT amounts and records them in the Automatic VAT 

account or in the VAT account that has been indicated by the user in the File and Accounting 

properties. 

Automatic VAT account  

As an alternative to the traditional system with several VAT accounts (Recoverable VAT, VAT 

due, VAT Revenue authority, VAT to be paid), it is possible to only have two accounts in the Chart 

of accounts: the Automatic VAT account and the account VAT to be paid. 

The Automatic VAT account, already configured in the Charts of Accounts of Banana Accounting,  

is already set up as the default account in the File and Accounting properties of the File menu. If, 

on the contrary, this account is not configured as the default account in the File and accounting 

properties, then the account should be indicated in the VAT Codes table, in the VAT account 

column. 

The program automatically transfers all the amounts, calculated according to the VAT codes that 

have been inserted in the VAT Codes table: 

 In debit, the recoverable VAT amounts are present 

 In credit, the due VAT amounts are present 

 In the last row, Balance column, the VAT amount that needs to be paid to the State can be 

found. This amount needs to correspond with the amount displayed in the VAT report. If 

this is not the case, then there are errors in the accounting.  
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Carrying the VAT account to zero at the end of a period  

At the end of every quarter (or period), the balance of the Automatic VAT account can be 

transferred to the VAT to be paid account. 

The VAT to be paid account will have zero as a balance at the moment the VAT is being paid. 

With this system it is possible to check the balance every quarter; in case of an error, it is easy to 

locate in which period the balance no longer corresponds. 

  

8.6 Credit note 

In case an operation, that has been entered at an earlier date, needs to be cancelled, the same VAT 

code that has been used for the initial operation needs to be entered with the minus sign (-). In this 

way the VAT is being rectified. 

Instead of using the minus sign prior to the VAT code, it is also possible to use the specific VAT 

codes for discounts that have been configured in the VAT Codes table. 

Example a of credit note  

When a product has been sold and the client finds a defect, usually a credit note on his behalf is 

being issued. The credit note implies a decrease of the income and as a result a recovery of the VAT 

(Sales tax). 

We enter an amount of 1.500.-, including 10% VAT, for sales.  
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Due to a defect of the sold products, we issue a credit note for the amount of 150.- to the client.   

 

For a recovery of the VAT on the amount of the credit note, the VAT code of the sales has to be 

entered with a minus (-) sign preceding the code. 

  

8.7 VAT Report 

The VAT Report elaborates and displays the VAT calculation according to the selected period and 

parameters. 

Procedure: 

 Select, from the Account1 menu, the VAT report command 
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When activated, the following options allow the user to include to including the following data in 

the VAT report: 

  

Include transactions 

All the transactions with VAT/Sales tax are included. 

Include totals by Account 

All totals of operations with VAT/Sales tax, grouped per individual account, are included. 

Include totals by Code 
All totals of operations with VAT/Sales tax, grouped per individual VAT code, are included. 

Include totals by Percentage 

All totals of operations with VAT/Sales tax, grouped per individual percentage, are included. 

Include unused codes 

Also the unused codes of the VAT Codes table will be listed. 

Use own (Group, Gr) grouping scheme 

The operations with VAT/Sales tax are grouped according to the groupings of VAT Codes table. 

Sort transactions by 

By activating this cell, the transactions are sorted on the basis of a preselected option (Date, Doc., 

Description, etc….). 

  

Partial report 

By specifying a code or a group and by activating the necessary options, the software calculates the 

total of the operations with VAT/Sales tax of 

 only code specified (by selecting from the list) 

 only group specified (by selecting from the list). 

  

Other sections 

The information relating to the other sections are available on the following internet pages: 
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 Period 

 Composition 

VAT Report / transactions with totals by code 

 

The overal total in the last row of the VAT report has to correspond with the amount for the end of 

period of the Automatic VAT account, Balance column, on the condition that both of them refer to 

the same period. 

The data of the VAT report can also be transferred to and elaborated by other programs (f.i. Excel, 

XSLT) and be presented in formats that are similar to the forms of the tax authority 

For Switzerland, one can automatically obtain a document similar to the form that has to be sent to 

the VAT office. This form shows the amount to enter for each number.  Please consult (in German, 

French, or Italian) MwSt-Formular 2011-2012. 

  

8.8 Swiss VAT management 

8.8.1 Clients and suppliers with VAT on cash received 

With the system of the VAT on cash received, there is no provision for entering transactions on the 

clients/suppliers accounts, for the expenses and income are being entered at the moment the 

payment is made or received. Only at thàt moment, the VAT code is being entered. However, in 

spite of this rule, it is still possible to enter the issued and received invoices by using the cost 

centers. 

Procedure: 

 Insert the clients' and suppliers' accounts as cost center CC3, defined with the semicolon in 

two different groupings, one for clients, another one for suppliers.  
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Entering the invoices of clients and suppliers  

The issued and received invoices are only getting registered in the cost centers. 

While being positioned in the Transactions table, Cost centers view: 

1. Enter the amount of the issued or received invoice in the Amount column 

2. Do not enter a debit or a credit account. 

3. Enter the cost center in the CC3 column: in positive when it concerns an issued invoice, 

preceded by the minus sign (in negative)  when it is a received invoice.  
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Entering the payments made to the suppliers and the payments received 

from the clients  

When the payment for an invoice is received or made, enter: 

1. The debit and the credit account 

2. The amount paid or received 

3. The VAT code for the purchase or sales operation 

4. Enter the cost center in the CC3 column, preceded by the minus sign (in negative)  when it 

is a payment received and in positive when it concerns a payment made to a supplier. 

 

Please note that the VAT code should be entered in the VAT Code column in the Base or the 

Complete VAT view.  

In order to avoid having to move from one view to another, the CC3 column can be displayed in the 

Base view. 

In the Account card of the cost center, the transactions of the client or the supplier are being 

displayed. 

 



247 

B A N A N A  A C C O U N T I N G  

Related documents  

 Cost and Profit Centers 

 Membership list 

  

8.8.2 VAT on cash received and transitories at the end of year 

There are two methods, established by the Federal Tax Administration, for the collection of the 

Value Added Tax (VAT): 

 Method according to the issued invoices - the determination of the VAT amount takes place 

at the moment the suppliers' invoices are received and the clients' invoices are issued. 

 Method according to the cash received - the determination of the VAT takes place at the 

moment that received payments for invoices or the payment of invoices appear. All those 

subject to VAT that manage the accounting operations with this method (after receiving the 

authorization from the office in charge), need to comply with the following regulations: 

1. During the accounting period, clients and suppliers should not be entered. 

2. The income/expenses need to be entered at the moment the payment is being registered. 

3. The VAT code needs to be inserted on the same row as the income or expenses account. 

Practical exemple showing how to enter transactions during the year 

 

In this case, for clients/suppliers management, we advise to use the cost centers. 

For the matter of the transitories (invoices issued for income/expenses, but not yet received or paid), 

only at the end of the year, carrying forward of the outstanding invoices of suppliers and clients is 

allowed. These issues are defined by the VAT regulations (Wegleitung 2001 zur Mehrwertsteuer, Z 

964, Seite 219). 

Starting from here, we present you one of the possible solutions: 
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Transitories at the end of the year 

At the end of the year, in order to exactly establish the profit or the loss of the accounting year, one 

needs to enter the transitories: 

 Expenses and income that refer to received and issued invoices at the end of the year, 

including outstanding projects, that will be paid and received in the following year. 

In this case, pay attention to not insert the expenses and income with the VAT code, for in the VAT 

report, the recoverable VAT and the VAT due have to be shown in the VAT report of the first 

quarter of the next year. 

In order to establish just the part of the expenses and the income (so without VAT) and entering the 

transaction correctly, one has to: 

  

In the Assets and Liabilities  

 In the Assets, open the account "Open client accounts" 

 In the Liabilities, open the account "VAT on open client accounts" 

 In the Liabilities, open the account "Open supplier accounts" 

 In the Assets, open the account "VAT on open supplier accounts" 
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In the expenses and income 

 In the expenses, open the account "Expenses for open supplier accounts" 

 In the income, open the account "Income for open client invoices" 
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In order to enter the transaction of the suppliers on 31.12....., one has to make an entry on several 

rows: 

 Enter in debit on the account "Expenses for open supplier accounts" the expense without 

VAT, without VAT code 

 Enter in debit, on the account "VAT on open supplier accounts" the recoverable VAT 

amount 

 Enter in credit, on the account "Open supplier accounts" the total amount (VAT included) 
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In the following year on 01.01..... the preceding operation needs to be closed, so the transaction is as 

follows: 

 Enter in debit, on the account "Open suppliers accounts" the total amount (VAT included)   

 Enter in credit, the expense without VAT, without VAT code 

 Enter in credit, on the account "VAT on open supplier accounts" the recoverable VAT 

amount 

 

At the moment the supplier's invoice is getting paid, the user has to enter the transaction as shown 

in the example at the beginning of this page, by inserting the VAT code as usual. 
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For the transitories of the client invoices, the same procedure is being applied, but by entering on 

the preconfigured accounts related to the open client accounts. 

  

8.8.3 Entering VAT at customs for import 

TVA paid in cash at import  

In order to recover the VAT paid at customs, the user needs to operate as follows: 

In the table VAT codes there has to be a VAT code of type 2, which allows to record the VAT 

amount to 100% 

 

In the Transactions table, enter the cash account in credit, the paid VAT amount and the 

corresponding VAT code. 

The program calculates the VAT amount at 100%, without creating differences in the recordings. 
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TVA paid at import by the shipping company  

The procedure is the same as the previous one, except for the fact that the transaction extends itself 

over several rows, since, at the moment the shipper's invoice is being paid, the shipping costs and/or 

the customs clearance may be included. 

Example: 

Payment of the shipper's invoice for a total of 210.- CHF: 20.- CHF for customs clearance, 70.- 

CHF for shipping costs and 120.- CHF for VAT advanced at customs. 

 

  

8.8.4 VAT on services obtained abroad (rev) 

All services obtained abroad must be included in the Swiss VAT report. Unlike the import of goods 

that are being cleared at customs, for services obtained abroad there are no customs papers, but the 

VAT for this type of operation must be calculated and paid anyway. 
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Codes to use for the self-imposed VAT  

In the VAT codes table, there are specific codes to be used for services obtained abroad: codes B80 

e B80-2. The difference between these two codes is the following: 

 with the B80 code, in the Amount column the gross amount with VAT must be entered; 

 with the B80-2 the VAT amount is entered directly, and it will be allocated at 100% in the 

VAT account. 

For  more information please visit the corresponding pages in Italian, German or French. 

 

Codes to use for recoverable VAT  

 with the M80 code, in the Amount column the gross amount with VAT must be entered 

 with the M80-2 code, the VAT amount is entered directly, and it will be allocated at 100% 

in the VAT account 

 with the I80 code, in the Amount column the gross amount with VAT must be entered. 
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Example using the codes B80-2 / M80-2  

The transaction will be registered on multiple rows and needs a transitory account for the self-

imposed VAT and the recoverable VAT: 

 First of all the expense of the service must be entered, without the VAT code, because this is 

service obtained abroad 

 The transitory account needs to be registered in debit, no account entered in the credit 

account, then the gross VAT amount needs the entered and for the VAT code, the VAT code 

B80-2 needs to be entered (for the self-imposed VAT) 

 In the next row, no account entered in the debit account, enter the transitory account in 

credit, enter the VAT amount and for the VAT code, enter M80-2 or I80 (depending if the 

transaction deals with costs of materials and services, or investments and costs of the 

financial year) 

 
  

  

At the end of the transaction, the transitory account shows a balance of zero. 
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8.8.5 Swiss VAT tax report - effective method 

Content not available in English. 

This content is available in German, French and Italian. 

8.8.6 Swiss VAT tax report - Flat tax rate method 

Content not available in English. 

This content is available in German, French and Italian. 

9 Addresses and labels management 

This is an application for managing data lists and printing labels. 

Charcteristics: 

 Free definition of the fields 

 Possibility of printing only the selected rows 

 Free setting of the label format 

 Copy/Paste addresses from other programs (Excel and Word) 

The Addresses and labels application is a full and free version. It is included in the trial version of 

Banana Accounting 7. 

  

Create a new file 

From the File menu choose the New command and select the Labels type. 

Choose between the 3 available option the one that meets your needs. 
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Labels with progressive numbers 

A table will open where the columns are progressive numeric fields. 

 

Address labels 

A table will open where there are specific columns for entering addresses. 
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Labels to be composed 

An empty table will open where columns must be created and named by the user, using the 

Columns setup command from the Data menu. 

 

 

Entering the data 

Regardless from the option you chose (progressive numbers fields, address labels or labels to be 
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composed), once you defined the fields, data can be entered: 

 

Printing the labels  

 The program centers the text on the label width and hight 

 The program automatically reduces the text size when long texts are entered 
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9.1 Print label 

From the Label1 menu you can access the labels setup and printing options. 

The program already offers many predefined label formats; it is however possible to setup 

personalized parameters throught the Default command. 
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In order to edit  the labels or the addresses settings you need to use the Manage compositions 

command. 

 

By selection the desider one, it is possible to edit its settings, delete, duplicate, rename ore create 

new labels or addresses. 
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9.1.1 Print 

 

First label starting position 

Decide on the position of the first label. For example, if 1 is entered in the horizontal and vertical 

fields, it refers to the upper left-hand corner of the page. 

No. copies of each label 

The value of 1, in this field, means only one copy of each label is wanted. 

Selected lines only 

If this cell is activated, only the selected rows will be printed. 

Warn if text exceeds label 

If the text goes beyond the margins for the label, the program will warn the user by sending an error 

message if this cell is activated. 
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9.1.2 Page settings 

 

Page 

Margins 

Input the size in centimeters; if no size is entered, the margin sizes will be zero. 

Number of horizontal labels 

Input the number of horizontal labels there are on the page. 

Number of vertical labels 

Input the number of vertical labels there are on the page. 

Print Landscape 

The page will be printed horizontally if this cell is activated. 

Label 

Margins 

It is possible to input a margin for each label; the values for the label margins must be input in 

centimeters. 

Center text horizontally 

Select this option to horizontally center the text for each label in the cell. 
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Center text vertically 

Select this option to vertically center the text for each label in the cell. 

Font size 

Base size 

This field shows the default font size. 

Reduce to fit, but no less than 

The program calculates the maximum font size possible for a given label, starting from 14 points all 

the way down to 8 points. The calculation is made taking into account both the height and width of 

the label. If a label has a line that is too long (or has too many rows) to be printed, then an error 

message will appear in the message window. Even if it is incomplete, the label will still be printed. 

 

Note: the printers will not print on the whole surface of a page because they need minimum 

margins. The program tries to adapt the single labels to the margin values required by the printer. 

  

9.1.3 Compose label 

 

Field list 

This is a list of all possible label fields; to insert a field, it is possible to work in two ways: 
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 Double-click on an element from the list 

 Click on an element from the list, confirming with the Add Field key. 

The field selected will be inserted at the position of the cursor in the View labels area. One can 

directly insert fields by writing the field name between the < Less and > Greater symbols. 

  

View labels 

Shows the disposition of the fields. The entries "<NAME FIELD>" will be replaced with the 

corresponding value of the table. 

Preserve line feeds and spaces. 

The program does not take eventual spaces and empty rows in consideration, in case this option is 

disactivated. 

  

9.1.4 Composition 

You can find the explanations of the following window at the Composition web page. 

 

9.1.5 Copy email list 

This feature allows the user to copy the email addresses of the email Address book. 

It is possible to copy all or only selected addresses. The type of delimiter that has to be used, can be 

chosen as well (Semicolon - comma - space - carriage return). 
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10 What to do if you get an error message 

If the program shows error messages: 

 Update your software to the latest available version, by downloading it at the following 

page: 

#3215 

Check that your opening balances are correct 

 Recalculate your accounting file by pressing Shift+F9 

 If you have a multi-currency accounting file, check thath the exchange rate differences have 

been calculated 

 You can look for the exchange rate difference transactions with the "Search for transaction 

differences" command from the Account1 menu. 
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